
 Title: AOS Protocol and Procedure: Stream Discharge Date:  10/11/2018 

NEON Doc. #:  NEON.DOC.001085 Author: N.Harrison Revision:  F 

 
 

Template_NEON.DOC.050006 Rev G 

 

 

 

AOS PROTOCOL AND PROCEDURE:  

STREAM DISCHARGE 

 

PREPARED BY ORGANIZATION DATE 

Nick Harrison AQU 09/28/2017 

Dylan Monahan AQU 02/03/2017 

Michael Fitzgerald AQU 10/07/2016 

Ryan Utz AQU 01/22/2013 

Glenn Patterson AQU 05/18/2011 

Keli Goodman AQU 03/30/2011 
  

APPROVALS ORGANIZATION APPROVAL DATE 

Kate Thibault SCI 10/11/2018 

Mike Stewart SE 10/10/2018 

   

   

 

RELEASED BY ORGANIZATION RELEASE DATE 

Anne Baslely CM 10/11/2018 

 

 

 

See configuration management system for approval history. 

 

The National Ecological Observatory Network is a project solely funded by the National Science Foundation and managed under cooperative agreement by Battelle. 

Any opinions, findings, and conclusions or recommendations expressed in this material are those of the author(s) and do not necessarily reflect the views of the 

National Science Foundation. 



 Title: AOS Protocol and Procedure: Stream Discharge Date:  10/11/2018 

NEON Doc. #:  NEON.DOC.001085 Author: N.Harrison Revision:  F 

 
 

Template_NEON.DOC.050006 Rev G 

 

 Change Record  

REVISION DATE ECO # DESCRIPTION OF CHANGE 

A 02/06/2014 ECO-01092 Initial release 

B 01/26/2015 ECO-02636 Migration to new protocol template 

C 02/29/2016 ECO-03662 Baseline of protocol following FOPs review 

D 02/03/2017 ECO-04480 
Updated to new template; changes to sampling 
frequency, point of zero flow, removal of 3 depth 
sampling 

E 09/28/2017 ECO-05292 

Baseline update of protocol sent to FOPS for review.  
Made slight revisions to Sections 1.1, 4.1, 4.2, 4.4, 4.5.  
Added definitions to Section 2.4.  Included language on 
continuous discharge calculation to Section 3.  Section 7: 
re-organized content  throughout; added instrument-
specific steps to flowmeter setup and measurement 
procedures; refined calibration procedures (did not 
change); added list of common data entry errors to post-
measurement review section based on NEON-9064; 
replaced Figure 7 with one that shows equations and 
natural control segments; revised PZF procedure based 
on NEON-8821; added additional language on natural 
control types and how they affect ratings; added 
additional steps to data entry and verification based on 
NEON-9064.  Added Appendix A which introduces plan 
for measuring river discharge.  Added additional citations 
into References section.  Made slight revisions to 
Appendix B.  Removed Appendix C.    

F 10/11/2018 ECO-05687 

Section A.2: removed the requirement that >30% of 
velocity measurement stations within a discharge 
transect must contain velocity values >0.01 m/s in order 
for a discharge measurement to be conducted.  Parser 
validation code now flags measurements that contain 
such low-velocity values.  Section A.3: increased 
minimum filer parameter settings to 40 seconds based 
on standards set forth by the USGS.  Section A.5: clarified 
station spacing requirements given wetted widths of 
channel.   
Section A6: updated equipment list for wadable 
discharge measurements; Section A7: provided 



 Title: AOS Protocol and Procedure: Stream Discharge Date:  10/11/2018 

NEON Doc. #:  NEON.DOC.001085 Author: N.Harrison Revision:  F 

 
 

Template_NEON.DOC.050006 Rev G 

 

instructions on how to setup first and last measurement 
stations given undercut left and right banks within the 
discharge transect; clarified the example that illustrate 
one and two-point velocity measurement techniques.  
Removed point of zero flow calculation requirement and 
instructions- this offset is now calculated within the 
stage-discharge rating curve code for each aquatic site.  
Point of zero flow calculations are no longer required to 
be measured by field ecologists.  Added Appendix B: 
measuring discharge at NEON large river sites using 
acoustic Doppler current profilers from a piloted boat; 
cross-referenced all Tables and Figures. 

 

 

 



 Title: AOS Protocol and Procedure: Stream Discharge Date:  10/11/2018 

NEON Doc. #:  NEON.DOC.001085 Author: N.Harrison Revision:  F 

 
 

i 

 

1 TABLE OF CONTENTS 

2 OVERVIEW .................................................................................................................................1 

2.1 Background ................................................................................................................................... 1 

2.2 Scope ............................................................................................................................................. 1 

2.2.1 NEON Science Requirements and Data Products ................................................................. 2 

2.3 Acknowledgments ......................................................................................................................... 2 

3 RELATED DOCUMENTS AND ACRONYMS .....................................................................................3 

3.1 Applicable Documents .................................................................................................................. 3 

3.2 Reference Documents ................................................................................................................... 3 

3.3 Acronyms ...................................................................................................................................... 3 

3.4 Definitions ..................................................................................................................................... 3 

4 METHOD – WADEABLE STREAMS ................................................................................................4 

5 SAMPLING SCHEDULE – WADEABLE STREAMS .............................................................................7 

5.1 Sampling Frequency and Timing ................................................................................................... 7 

5.2 Criteria for Determining Onset and Cessation of Sampling .......................................................... 7 

5.3 Timing for Laboratory Processing and Analysis ............................................................................ 8 

5.4 Sampling Specific Concerns .......................................................................................................... 8 

5.5 Factors That May Negatively Impact Measurement Results: ....................................................... 8 

5.6 Criteria for Permanent Reallocation of Sampling Within a Site.................................................... 8 

6 SAFETY .......................................................................................................................................9 

7 PERSONNEL AND EQUIPMENT ................................................................................................... 10 

7.1 Equipment ................................................................................................................................... 10 

7.2 Training Requirements ................................................................................................................ 12 

7.3 Specialized Skills .......................................................................................................................... 12 

7.4 Estimated Time ........................................................................................................................... 12 

8 STANDARD OPERATING PROCEDURES ....................................................................................... 13 

9 REFERENCES ............................................................................................................................. 34 

APPENDIX A QUICK REFERENCES ................................................................................................ 36 



 Title: AOS Protocol and Procedure: Stream Discharge Date:  10/11/2018 

NEON Doc. #:  NEON.DOC.001085 Author: N.Harrison Revision:  F 

 
 

ii 

APPENDIX B RIVER DISCHARGE  ................................................................................................. 38 

B.1 Introduction ................................................................................................................................ 38 

B.2 Required Equipment and Materials ............................................................................................ 39 

B.3 Methods: Pre-Measurement Setup ............................................................................................ 41 

B.4 Methods: ADCP Serial Connections Setup .................................................................................. 42 

B.5 Methods: Trimble GPS Receiver and Tornado Antennae Setup ................................................. 43 

B.6 Methods: Starting a New Measurement in WinRiver II .............................................................. 46 

B.7 Methods: Pre-Measurement QAQC ............................................................................................ 49 

B.7.1  Setting the ADCP Clock ............................................................................................................... 50 

B.7.2 Execute an ADCP Test ................................................................................................................. 50 

B.7.3 Calibrate the Compass ................................................................................................................ 50 

B.7.4 Perform a Moving Bed Test ........................................................................................................ 53 

B.7.5 Configure the Reference Navigation ............................................................................................. 57 

B.8 Methods: Collecting Stream Discharge Data .............................................................................. 57 

B.8.1 Begin Acquiring Data ..................................................................................................................... 57 

B.8.3 Hold Position at the Starting Channel Edge ................................................................................... 61 

B.8.4 Cross the Channel .......................................................................................................................... 61 

B.8.5 Holding Position at the Ending Channel Edge ................................................................................ 62 

B.8.6 Collect At Least Three Additional Transects (Minimum of Four Total Required) .......................... 63 

B.8.7 Evaluate Whether More Than Four Transects Are Required ........................................................ 64 

B.8.7 Transect Locations ......................................................................................................................... 66 

B.9 Methods: Field Data Review ....................................................................................................... 68 

B.10 Methods: Uploading the Measurement File ............................................................................... 69 

 

 

LIST OF TABLES AND FIGURES 

Table 1. Required sampling frequency for wading discharge measurements at NEON aquatic sites with 

wadeable streams. ........................................................................................................................................ 7 

Table 2. Equipment list – Field equipment ................................................................................................. 10 

Table 3. Station spacing relative to wetted width. ..................................................................................... 21 



 Title: AOS Protocol and Procedure: Stream Discharge Date:  10/11/2018 

NEON Doc. #:  NEON.DOC.001085 Author: N.Harrison Revision:  F 

 
 

iii 

Table 4. Velocity point methods are based on station depth. ................................................................... 24 

Table 5. Equipment list – Field equipment for river discharge measurement. .......................................... 39 

 
Figure 1. Discharge transects must be placed on a run or riffle associated with the pool that the staff 

gauge and pressure transducer is placed. .................................................................................................... 6 

Figure 2. Velocity meter and the thumbscrew that attaches it to the wading rod. ................................... 15 

Figure 3. Hach FH950 velocity meter showing the “Start” menu. .............................................................. 16 

Figure 4. Example of well-distributed stations across a discharge transect that exhibits laminar flow.  S0-

S12 represent stations and dashed rectangles represent sub-sections. .................................................... 21 

Figure 5. Example of un-even station spacing due to un-even flow distribution across the discharge 

transect. ...................................................................................................................................................... 21 

Figure 6. Wading rod adjustments at 60% (one-point), and 20% and 80% (two-point) depths. Station 

depth = 0.72m. ............................................................................................................................................ 25 

Figure 7. Example of stage-discharge rating curve. Circles indicate discharge measurements collected 

across a wide range of gauge heights.  Rating equations for each of the three distinct segments are 

shown representing low, medium, and high flow regimes.  In this example, a section control governs the 

stage-discharge relationship during the low-flow regime and the main channel control becomes de-

activated at higher stages when as the streamflow tops the banks.  Once flow exceeds the channel 

capacity the stage-discharge relationship is governed by floodplain channel control. ............................. 31 

Figure 8. Schematic representation of control range in a rating curve.  (Illustration: Braca 2008) ........... 32 

Figure 9. ADCP to PC serial cables.  Make sure that an RS-232 adapter (blue and white 9-Pin male to USB 

with FTDI driver) is included in this set.  Also included are the 12V batter connectors (red and black 

clamps) as well as the cable that connects to the ADCP (black covered cable with a loop on the end). ... 42 

Figure 10. Trimble to PC connection serial cables.  This set contains three cables that must be attached: 

the Trimble to 9-pin (male); the 9-pin (female) to 9-pin (female); and the RS-232 9-pin (male) to USB. .. 43 

Figure 11. Verify that NMEA output is activated on the Trimble receiver. ................................................ 44 

Figure 12. Proper setup of the Trimble receiver using the three serial cables .......................................... 45 

Figure 13. Above: Proper compass calibration and Magnetic Variation coupled with good GPS data – 

lines are in agreement.  Below: Poor compass calibration and/or Magnetic Variation is not set correctly.  

Lines are not in agreement.  Check calibration, Magnetic Variation value, and potential Moving Bed 

conditions.  Check GPS coverage, latency, and satellite conditions. .......................................................... 52 

Figure 14. Illustration of the Loop Moving Bed Test procedure. ................................................................ 54 

Figure 15. Left: A moving bed is likely present (not open loop); Right: a moving bed is not likely present 

(note closed loop). ...................................................................................................................................... 54 

Figure 16. Loop Test Result window ........................................................................................................... 56 

Figure 17. Velocity Contour Graph ............................................................................................................. 60 

Figure 18. Velocity Tabular Display showing two good bins in red indicating that the location is valid 

transect start and end point.  Note the discharge values in the far right columns. ................................... 60 

Figure 19. Water Speed vs. Boat Speed graph.   Above: Improper technique.  The boat speed (purple 

line) is erratic and higher than the water velocity (red line).  Below: Proper technique.  Maintain an even 



 Title: AOS Protocol and Procedure: Stream Discharge Date:  10/11/2018 

NEON Doc. #:  NEON.DOC.001085 Author: N.Harrison Revision:  F 

 
 

iv 

boat speed so that the purple and red lines are more in line and boat speed remains generally lower 

than water speed. ....................................................................................................................................... 62 

Figure 20. Defining transect locations. ....................................................................................................... 66 

Figure 21. Editing transect locations. ......................................................................................................... 67 

Figure 22. Loading location files ................................................................................................................. 68 

Figure 23. A black line is displayed between saved transect locations in the Ship Track display window. 68 

 

  



 Title: AOS Protocol and Procedure: Stream Discharge Date:  10/11/2018 

NEON Doc. #:  NEON.DOC.001085 Author: N.Harrison Revision:  F 

 
 

Page 1 of 73 
 

2 OVERVIEW 

2.1 Background 

The degree to which streamflow, or discharge, affects the structure of stream and river ecosystems 

cannot be overstated.  Stream ecologists consider discharge a master variable, as varying rates of 

discharge directly affect the physical, chemical, and thermal attributes of the stream ecosystems. High 

flow events have the ability to entirely reshape the physical habitat of streams by repositioning large 

woody debris, sediment, and boulders within the active channel, or the active channel itself. Flow rates 

often directly affect water temperatures, particularly during flood and low-flow events (Poole and 

Berman 2001). Surface water discharge rates directly affect flow through the hyporheic zone (space 

between sediments in the benthic zones of streams) as well, where microbial activity is concentrated. 

Consequently, discharge can directly affect nutrient cycling in streams (Grimm and Fisher 1984). 

Because of these and other interactions between discharge and the physicochemical attributes of 

streams, flow regime characteristics have been found to be significantly correlated with life history 

attributes of stream-dwelling organisms such as fishes (Mims and Olden 2012).  

Flow regimes in stream and rivers worldwide are rapidly changing due to environmental stressors, 

consequentially affecting the ecological services these systems support. Climate change impacts the 

timing, magnitude, and severity of flood and drought events with profound consequences for lotic 

ecosystems. For example, peak flows in western North American rivers are consistently occurring earlier 

in the spring (Clow 2010) and these changes may significantly alter the habitat suitability for species 

such as cutthroat trout (Zeiglar et al. 2012). Land use change from natural cover to human-dominated 

landscapes can also affect discharge. Impervious surfaces (such as roads and rooftops) in urban 

landscapes transfer water directly to stream channels, resulting in elevated flood frequencies and 

magnitudes (Schoonover et al. 2006). Agricultural lands may also impact flow regimes either by reducing 

flows directly through withdrawals or elevating flow when soils become compacted (Dodds et al. 2004). 

All flow regime changes associated with land use substantially impact the biological communities that 

reside in the receiving waters (Cuffney et al. 2010, Dodds et al. 2004).  

Because discharge is fundamentally important to stream ecosystems, NEON will calculate discharge in all 

rivers and stream sites within the Observatory. The discharge data product will be a crucial input to a 

number of additional high-level NEON data products, such as stream metabolism and nutrient fluxes. 

Consequently, discharge represents a critical component in the NEON Aquatic Observation System.  

2.2 Scope 

This document provides a change-controlled version of Observatory protocols and procedures.  

Documentation of content changes (i.e. changes in particular tasks or safety practices) will occur via this 

change-controlled document, not through field manuals or training materials. 
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2.2.1 NEON Science Requirements and Data Products 

This protocol fulfills Observatory science requirements that reside in NEON’s Dynamic Object-Oriented 

Requirements System (DOORS). Copies of approved science requirements have been exported from 

DOORS and are available in NEON’s document repository, or upon request. 

Execution of this protocol procures samples and/or generates raw data satisfying NEON Observatory 

scientific requirements. These data and samples are used to create NEON data products, and are 

documented in the NEON Scientific Data Products Catalog (RD[03]). 

2.3 Acknowledgments 

NEON acknowledges the current definitive work on this topic, “Discharge Measurements at Gaging 

Stations”, U.S. Geological Survey Techniques and Methods Book 3, Chapter A8, by D. Phil Turnipseed 

and Vernon B. Sauer (2010).  
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3 RELATED DOCUMENTS AND ACRONYMS 

3.1 Applicable Documents 

Applicable documents contain higher-level information that is implemented in the current document. 

Examples include designs, plans, or standards.  

AD[01] NEON.DOC.004300 EHS Safety Policy and Program Manual 

AD[02] NEON.DOC.004316 Operations Field Safety and Security Plan 

AD[03] NEON.DOC.000724 Domain Chemical Hygiene Plan and Biosafety Manual 

AD[04] NEON.DOC.050005 Field Operations Job Instruction Training Plan 

AD[05] NEON.DOC.004104 NEON Science Performance QA/QC Plan 

3.2 Reference Documents 

Reference documents contain information that supports or complements the current document. 

Examples include related protocols, datasheets, or general-information references. 

RD[01] NEON.DOC.000008 NEON Acronym List 

RD[02] NEON.DOC.000243 NEON Glossary of Terms 

RD[03] NEON.DOC.005003 NEON Scientific Data Products Catalog 

RD[04] NEON.DOC.001271 NEON Protocol and Procedure: Manual Data Transcription 

RD[05] NEON.DOC.001646 General AQU Field Metadata Sheet 

3.3 Acronyms 

Acronym Definition 

LEW Left edge of water (looking downstream) 

P&P Procedure and Protocol 

REW Right edge of water (looking downstream) 

USGS U.S. Geological Survey 

SDRC Stage Discharge Rating Curve 

3.4 Definitions 

Area (A): The cross-sectional area of a stream or a subsection of a stream. For a rectangular subsection, 

it is the width times the depth. For an irregular cross-section, it is the summation of a series of 

subsection areas, or the width times the average depth. 

Control: A specific section of a stream channel, located downstream from the staff gauge that controls 

the relation between gauge height and discharge at the staff gauge.   

Depth (D): The depth of the water column at a particular point, measured from the water surface to the 

stream bottom. 
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Discharge (Q): (streamflow) The volume of water flowing through a cross-section during a given period 

of time, measured in units of volume per unit time, such as cubic feet per second, cubic meters per 

second, liters per second, gallons per minute, or acre-feet per year. Discharge is computed as velocity x 

area. 

Left edge of water (LEW): The edge of the stream that is on the observer’s left when looking 

downstream. 

Right edge of water (REW): The edge of the stream that is on the observer’s right when looking 

downstream. 

Stage: (i.e. stream height, water level) Height of a stream or river relative to a fixed point. Stage can be 

measured at a single point in time by reading the water level on a calibrated staff gauge mounted in the 

stream channel, or by using a weighted measuring tape to measure down from a fixed point to the 

water surface. Stage can also be measured continuously with a pressure, optic or acoustic sensor, or a 

staff gauge. 

Stage Discharge Rating Curve (SDRC): An empirical relationship (formula) between a stream stage and 

the associated discharge at given stage, which allows automated measurements of stage to be 

converted to discharge.  

Station: A location along the stream discharge measurement transect where velocity and depth are 

measured and area and streamflow are calculated.  Station, or vertical, spacing is dependent on the 

wetted width of the channel and velocity distribution throughout the transect.    

Thalweg: The line that connects the deepest part of the active channel.   

Transect: The stream cross-section under the measuring tape stretched across the measuring section, 

along which velocity measurements are made to compute discharge. 

Velocity (V): The speed of water flowing past a point along the transect, measured in liters per second. 

Wetted Width: Width of a stream channel that contains water. As water levels fluctuate in streams, the 

wetted width may as well, depending on the cross-sectional shape of the channel.  

4 METHOD – WADEABLE STREAMS 

A continuous record of stream discharge is derived using discharge measurement and observed gauge 

height data collected by field technicians and raw depth data collected by in-situ pressure transducers at 

each NEON aquatic site that contains a wadeable stream.   Stage-discharge rating curves are developed 

that regress observed gauge heights (or stage) against a measurement of streamflow, or discharge.  To 

build a stage-discharge rating curve NEON field personnel measure discharge data across a wide range 

of stream stage levels. These sampling events are known as wading surveys.  During a wading survey 
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discharge is a calculated metric obtained from a series of stream velocity and area measurements 

collected along a fixed cross-section in the stream (Figure 1).  Velocity and area measurements are then 

integrated into a single value of stream discharge that is associated with the gauge height (or stage) 

during the measurement.  

Once the rating curve is established, and barring significant changes in channel morphology due to 

stochastic events, a single measurement of water column depth in the stream channel is sufficient to 

estimate streamflow. Hence, a pressure transducer located at a fixed location in the stream is able to 

yield a continuous estimate of stream discharge by measuring water depth. 

Each NEON aquatic site contains an in-stream staff gauge that is located in a fixed positioned near a 

Level Troll which automatically measures and logs absolute pressure values in-situ at one-minute 

intervals throughout the year, or while water is present within the sub-reach.  Absolute pressure data is 

converted to raw depth using CAL/VAL calibration coefficients.  During each wading survey technicians 

record gauge height.  The raw depth values derived from the pressure transducer are regressed against 

gauge height measurements collected throughout the water year to derive an equation that transforms 

raw depth to stage.  A continuous record of stream discharge is derived by applying stage-discharge 

rating equations to continuous stage data.  During the site characterization period, in-stream and 

barometric pressure is measured at 15-minute intervals by HOBO transducers which provide data that is 

converted to continuous stage and discharge in a similar manner.    

The purpose of this protocol is to provide detailed instructions on how to successfully implement a 

discharge wading survey.  This involves pre-deployment and post-measurement review, step-by-step 

field methods, data entry procedures, troubleshooting, instrument quality assurance plans, and safety 

guidelines specific to NEON sites and personnel.  The methods detailed in this document follow the 

United States Geological Society (USGS) protocols (Rantz et al. 1982, Turnipseed and Sauer, 2010). 

Wading surveys involve positioning a velocity meter sensor attached to a rod in the flowing stream. The 

velocity meter is designed to measure the speed of water around the sensor tip, yielding an 

instantaneous localized velocity measurement. To obtain an estimate of total stream discharge within 

the cross-section, the stream is divided laterally into sub-sections. Within each sub-section, an 

instantaneous velocity magnitude is obtained and transformed to a volumetric discharge magnitude by 

applying the velocity across the full sub-section area. Total stream discharge is then calculated by 

summing up the discrete volumetric discharges for each sub-section. Should site-specific conditions 

become unfavorable for wading surveys, such as insufficient water levels or velocities, alternative 

methods may need to be performed.  Science staff will make this decision based on site conditions and 

site constraints.  

While the rating curve is under initial development, it is particularly important to perform wading 

surveys frequently in order to form the basis of the stage-discharge relationship. NEON’s target is to 

conduct 24 discharge surveys over a wide range of stage levels until Science has approved a valid SDRC. 
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Once the rating curve has undergone this initial development, it is important to check the rating 

periodically, as it may shift due to scour, aggradation, or other changes in channel geometry. Channel 

morphology in streams with unconsolidated bed materials is expected to fluctuate (to varying degrees) 

on an annual and storm-event basis.  As a result, rating curves for these channel types will require more 

frequent measurements than those for bedrock channels, which are more stable. NEON’s target is to 

use wading surveys to verify the rating curve twelve (12) times per year across a range of stages. 

Discharge surveys that occur during and following high-flow events (which may substantially alter 

channel geometry) are especially important for detecting shifts in the stage-discharge relationship. 

 
Figure 1. Discharge transects must be placed on a run or riffle associated with the pool that the staff gauge and 
pressure transducer is placed.   

 

Standard Operating Procedures (SOPs), in Section 7 of this document, provide detailed step-by-step 

directions, contingency plans, sampling tips, and best practices for implementing this sampling 

procedure. To collect an accurate discharge measurement, field technicians must follow the protocol 

and associated SOPs. Use NEON’s problem reporting system to resolve any field issues associated with 

implementing this protocol. 

The value of NEON data hinges on consistent implementation of this protocol across all NEON domains, 

for the life of the project. It is therefore essential that field personnel carry out this protocol as outlined 



 Title: AOS Protocol and Procedure: Stream Discharge Date:  10/11/2018 

NEON Doc. #:  NEON.DOC.001085 Author: N.Harrison Revision:  F 

 
 

Page 7 of 73 
 

in this document. In the event that local conditions create uncertainty about carrying out these steps, it 

is critical that technicians document the problem and enter it in NEON’s problem tracking system.  

Quality assurance will be performed on data collected via these procedures according to the NEON 

Science Performance QA/QC Plan (AD[05]). 

5 SAMPLING SCHEDULE – WADEABLE STREAMS 

5.1 Sampling Frequency and Timing 

Stream discharge must be measured at aquatic sites with wadeable streams a minimum of twenty-four 

(24) times in order to establish an SDRC followed by twelve (12) times per year to validate and refine the 

rating (Table 1).  After the first year of sampling, the SDRC will be reviewed and approved by NEON 

Science.  If SDRC is not approved by Science, then Science will request that field operations staff 

schedule additional sampling bouts to fill in data gaps needed to improve the SDRC. 

Following each sampling bout after the SDRC has been established, field technicians must compare the 

measured discharge value to the predicted value derived from the rating.  Consecutive discharge 

sampling bouts that yield discharge values greater than ± 10% of the predicted value may be an 

indication that the stage-discharge relationship at a given site has changed, or shifted.  Sampling 

frequency must then be increased in order to validate a potential shift, which, if validated, would result 

in a new rating equation.  Shift validation typically involves targeting sampling bouts to occur during 

stage levels.  If a rating shift is validated Science will direct field operations staff to increase annual 

sampling frequency to 24 measurements.  More information regarding identifying and reporting 

potential rating shifts is available in SOP A.8.   

Table 1. Required sampling frequency for wading discharge measurements at NEON aquatic sites with wadeable streams.   

Domains Sampling Dates Sampling Bouts per Year 

All Domains: pre-SDRC establishment Year-round (as feasible) 24  

All Domains: post-SDRC establishment Year-round (as feasible) 12  

 

5.2 Criteria for Determining Onset and Cessation of Sampling 

 Data collection: 

a) Is there flowing water in the stream channel? If NO then STOP; If YES, proceed to (1b) 

b) Is the staff gauge absent from the site or has it been displaced in any way?  If YES then 

STOP, if NO, proceed to (1c) 

c) Is >30% of the transect at a depth >0.06m? If NO then consider implementing PZF 

methodology ; if YES, proceed to (1d) 

d) Is there sufficient time to collect a discharge survey? If NO then STOP; if YES, perform 

discharge survey 
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5.3 Timing for Laboratory Processing and Analysis 

There is no domain lab processing for this protocol. 

5.4 Sampling Specific Concerns 

 If technicians determine that logs, boulders, thick ice and or other submerged objects 

immediately upstream or downstream of the transect influence the streamflow at the 

specific measurement station, do no collect a discharge measurement.  Technicians shall 

submit a trouble ticket that includes pictures or videos of the obstruction, and consult with 

Science.   

5.5 Factors That May Negatively Impact Measurement Results: 

 Rapidly changing stage (> ~0.10m) during the discharge measurement; 

 Velocities that are outside the range of the flowmeter to accurately measure; 

 Dropping equipment into the stream; 

 Heavy precipitation; 

 Severe cold or wind; 

 People or animals approaching the sampler while in the stream; 

 Low or dead batteries in the current meter; 

 Errors in reading or entering data in the handheld velocity meter; 

 Using the meter in the wrong mode, such as getting readings in English rather than metric 

units; 

 Failure to read or set the depth on the wading rod in the correct manner; 

 Failure to stretch the tape line perpendicular to the direction of flow; 

 Improper site selection (too slow, too shallow, effects of backwater, too turbulent, too 

many rocks and eddies, undercut banks, bends, large woody debris, other obstructions); 

 Insufficient attention to the protocol 

5.6 Criteria for Permanent Reallocation of Sampling Within a Site 

Discharge sampling will occur on the schedule described above at one location per site. Ideally, sampling 

will occur at these sampling locations for the lifetime of the Observatory (core sites) or the duration of 

the site’s affiliation with the NEON project (relocatable sites). However, circumstances may arise 

requiring that sampling within a site be re-located from one particular location to another. In general, 

sampling is considered to be compromised when sampling at a location becomes so limited that data 

quality is significantly reduced. If sampling at a given transect becomes compromised, a trouble ticket 

should be submitted by Field Operations to Science.  
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There are two main pathways by which sampling can be compromised. Sampling locations can become 

inappropriately suited to answer meaningful biological questions (i.e., a high flow event significantly 

alters the discharge cross-section), or sampling locations may become located in areas that are 

logistically impossible to sample on a schedule that that is biologically meaningful.  

 

6 SAFETY 

This document identifies procedure-specific safety hazards and associated safety requirements. It does 

not describe general safety practices or site-specific safety practices. 

Activities in streams should only be performed when flow conditions are safe.  Do not attempt to wade a 

stream where (velocity x depth) is ≥ 10 ft2/s (0.93 m2/s) 

Personnel working at a NEON site must be compliant with safe fieldwork practices as outlined in the 

Operations Field Safety and Security Plan (AD[02]) and EHS Safety Policy and Program Manual (AD[01]).  

Additional safety issues associated with this field procedure are outlined below.  The Field Operations 

Manager and the Lead Field Technician have primary authority to stop work activities based on unsafe 

field conditions; however, all employees have the responsibility and right to stop their work in unsafe 

conditions. 
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7 PERSONNEL AND EQUIPMENT 

7.1 Equipment 

Specific equipment is needed to implement the procedures in this document (Table 2). Equipment lists are organized by task. They do not 

include standard field and laboratory supplies such as charging stations, first aid kits, drying ovens, ultra-low refrigerators, etc. 

Table 2. Equipment list – Field equipment 

Supplier 
Supplier 
Number 

R/S Description Purpose 

Q
u

an
ti

ty
 

Sp
e

ci
al

 

H
an

d
lin

g 

Durable items 

  R 
Survey Tape (15-100m, site 
specific lengths) 

Establishing the transect 1 N 

Amazon  
Ben Meadows  

 
B001JYXXH8 

100952 
 

R Stakes  Anchoring survey tape 2 N 

McMaster-Carr  50065A21 S Clamps Attaching and securing tape to stakes 2 N 

Grainger, W.W. 34A216 R 5 Gallon Bucket Zero Calibration of sensor 1 N 

Hach Company 
1040500195S 

10405005950N 
R Velocity Meter (Ex. Hach FH950.1) Measuring velocity 1 N 
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Supplier 
Supplier 
Number 

R/S Description Purpose 

Q
u

an
ti

ty
 

Sp
e

ci
al

 

H
an

d
lin

g 

Fondriest 
Environmental, 
Inc. 105-009 

R Top setting wading rod Measuring velocity 1 N 

Ben Meadows  
Grainger 
Forestry 
Suppliers 
Cabela's 

 R Waders (per person) Safe wading 1 N 

  R 
Personal Flotation Device (at sites 
where required) 

Safe wading 1 N 

Consumable items 

   No Consumable Items    

R/S=Required/Suggested 
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7.2 Training Requirements 

All technicians must complete required safety training and protocol-specific training for safety and 

implementation of this protocol as required in Field Operations Job Instruction Training Plan (AD[04]). 

Personnel should be:  

 Trained in Water Safety Awareness 

 Trained in making wading discharge measurements 

 Adept at wading in streams. 

7.3 Specialized Skills 

N/A 

7.4 Estimated Time 

Once at the discharge site, one discharge transect should take from setup to completion between 0.5 

and 1.75 hours.  Time spent will increase if the technician needs to sample the transect more than once.    
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8 STANDARD OPERATING PROCEDURES 

SOP A Field Sampling 

A.1 Prior to Leaving the Office 

 Ensure that the flow meter is fully charged. 

 Gather and prepare all necessary equipment (See Table 2 for equipment list). 

 If a site has an approved SDRC, current rating equations must be available in order to 

compare measured vs. predicted discharge values.  Once established, rating equations will 

be provided to FOPs via the Fulcrum platform.    

A.2 Navigate to the Discharge Transect 

 If a discharge transect, or cross-section, has already been established, the bounds should be 

permanently marked using stakes or plot markers (one on each side of the stream).  

Navigate to this location and  proceed to Step 3. 

 

 If a discharge transect has not been established at the site proceed with the following steps: 

 

a) Determine an appropriate location to establish a discharge transect. 

 

o The transect location must be located in the riffle habitat unit in close proximity 

(just downstream) of the pool where the staff gauge and sensor set are installed 

(typically this is the S2 sensor set location).   Request coordinates from Science if the 

S2 location is unknown or has not yet been established.   

 

o An ideal discharge transect will: 

 Be located in a reasonably straight channel with velocity lines that are more 

or less parallel to each other; 

 Contain velocities that are, for the most part, > 0.15 m/s, and depths that 

are, for the most part, 0.15m; 

 Contain a stable streambed free of obstructions that would create eddies, 

slack water, and turbulence; 

 Contain measurement sections that are roughly parabolic, trapezoidal, or 

rectangular; 

 Contain a stable downstream control feature. 

 

o Take a picture of the transect location that best meets this criteria as well as the 

downstream control feature and send to Science for consultation. 

 



 Title: AOS Protocol and Procedure: Stream Discharge Date:  10/11/2018 

NEON Doc. #:  NEON.DOC.001085 Author: N.Harrison Revision:  F 

 
 

Page 14 of 73 
 

 Prior to collecting the discharge measurement identify any instrumentation or 

environmental issues that would negatively affect data quality.  If conditions are 

unfavorable to discharge measurement collection, submit a trouble ticket and consult with 

Science.   

 

Unfavorable conditions include, but are not limited to: 

 

a) The staff gauge is either not present or has been displaced in some way. 

 

o A discharge measurement should not be collected if a staff gauge is not present at 

the site or the gauge has been displaced in any way.  Submit a trouble ticket to 

Science that includes photos of the gauge.   

 

b) A pressure transducer or Level Troll is either not present or has been displaced in some 

way.   

 

o A discharge measurement may be collected in the event that the pressure 

transducer is missing or has been displaced.  However the absence of this 

instrument prevents continuous discharge from being estimated.  Submit a trouble 

ticket to Science immediately if the Level Troll is missing or has become displaced.     

 

c) Too much water is present in the channel to safely conduct the wading survey. Refer to 

NEON Operations Field Safety and Security Plan (AD[02]) for details.  If the transect has 

too much water flowing to safely measure discharge do not collect a discharge 

measurement and submit a trouble ticket to Science for consultation.     

 

d) There is an insufficient amount of water in the channel to conduct velocity 

measurements.   

 

o A minimum water level of 0.06 meters is required to conduct the discharge 

measurement at each sampling station within the transect. Depths less than 0.06m 

may cause bias in the velocity reading.  Note that edge stations are typically shallow 

and often contain depths < 0.06m.   

 

o Do not collect a discharge measurement if >30% of the depths within the sampling 

stations of the discharge transect are < 0.06m.  Submit a trouble ticket to Science in 

this instance.  
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e) Environmental issues that can affect sampling such as thunderstorms (refer to NEON 

Operations Field Safety and Security Plan (AD[02] for details), or frozen stream surfaces 

(refer to NEON Operations Field Safety and Security Plan (AD[02] for details). 

 

o If the water surface is “lightly iced” over (< 1” of ice) and you can safely break 

through the ice to clear/open up a 1m width along the entire discharge transect, 

collect a discharge measurement.  On the General Field Metadata sheet RD[05] 

record ice conditions and indicate that surface ice was broken in order to collect the 

measurement. 

 

o If the surface ice thickness is > 1”, do not collect a stream discharge measurement.    

 

A.3 Preparing to Measure Discharge: Setup Flowmeter and Check Flowmeter Settings  

It is very important that the flowmeter settings are set correctly in the handheld units.  Incorrect 

settings will negatively affect data quality and, in some instances, prevent the discharge file 

from being uploaded onto the SOM portal (see SOP A.8).  Follow the steps below to setup the 

flowmeter and ensure that flowmeter settings are correct prior to measuring discharge.   The 

most common flowmeter currently at use at NEON aquatic sites with wadeable streams is the 

HACH FH-950.  The following steps detail calibration procedures for this model.  If another 

flowmeter is used for discharge, consult with Science regarding unique calibration settings.         

 Attach the flowmeter to the rod. 

a) Ensure the hexagonal flowmeter rod is attached properly to the rod base. The base and 

rod screw together, so tighten if loose.  

b) Attach the velocity flowmeter to the mounting shaft of the wading rod, using the 

thumbscrew (Figure 2).   Do not touch the tip of the sensor bulb, residue from oil on 

your fingers and hands can negatively affect the calibration procedures.   

 
Figure 2. Velocity meter and the thumbscrew that attaches it to the wading rod. 
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 Turn the flowmeter on by pressing and holding the “ON/OFF” button on the outside of the 

handheld instrument.  Note that the meter may first run a diagnostic check to ensure it is 

connected to the sensor.  Once complete, the Start Menu will appear on the screen, as 

shown in Figure 3.  

 

 
Figure 3. Hach FH950 velocity meter showing the “Start” menu. 

 

 Set Measurement Units.  

a) From the Start Menu, select “Setup” and press OK. 

b) Select “More” at the bottom of the screen. 

c) Select “Units” and press OK. 

d) Select “Metric” and press OK. 

e) Under the “Select function” screen, select “Velocity” and press OK. 

f) Select “m/s” and press OK.   

g) The “Parameters successfully saved” screen will appear.  Press OK. 

h) Select “flow” and press OK. 

i) Select “liters/s” and press OK. 

j) The “Parameters successfully saved” screen will appear.  Press OK. 

k) Select “depth” and press OK. 

l) Select “m” and press OK. 

m) The “Parameters successfully saved” screen will appear.  Press OK. 

n) Select “area” and press OK. 

o) Select “m2” and press OK.   

p) The “Parameters successfully saved” screen will appear.  Press OK. 

q) Once all units have been set correct, press OK. 

 

 Set Filter Parameters. 

a) From the Start Menu, select “Setup” and press OK. 

b) Select “Filter Parameters” and press OK. 
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c) Select “Main filter” and press OK. 

d) Select “Fixed Period Averaging” and press OK. 

e) In averaging time box, enter a value of “40” and press OK.  This is the amount of time 

the flowmeter will spend averaging the velocity measurements.   

f) The “Parameters successfully saved” screen will appear.  Press OK. 

g) Check that “Pre-filter” is enabled and the data acquisition pre-filter rank is set to “5”.  

These are default values and should not be changed.   

 

 Set Flow Calculation Method. 

a) From the Start Menu, select “Setup” and press OK. 

b) Select “More” at the bottom of the screen. 

c) Select “Flow Calculation” and press OK. 

d) Select “Mid-section” and press OK. 

e) The “Parameters successfully saved” screen will appear.  Press OK. 

 

 Set Station Entry Method. 

a) From the Start Menu, select “Setup” and press OK. 

b) Select “More” at the bottom of the screen. 

c) Select “Station Entry” and press OK. 

d) Select “Non-Fixed” and press OK. 

e) The “Parameters successfully saved” screen will appear.  Press OK. 

 

 Set Measurement Resolution. 

a) From the Start Menu, select “Setup” and press OK. 

b) Select “More” at the bottom of the screen. 

c) Select “Measurement Resolution” and press OK. 

d) Select “0.001” and press OK. 

e) The “Parameters successfully saved” screen will appear.  Press OK. 

 

 Set Auto-Zero Mode. 

a) From the Start Menu, select “Setup” and press OK. 

b) Select “Auto Zero Depth” and press OK. 

c) Select “On” and press OK. 

d) The “Parameters successfully saved” screen will appear.  Press OK. 

 

 Set EMI. 

a) From the Start Menu, select “Setup” and press OK. 

b) Select “EMI” and press OK. 

c) Select “60Hz.” and press OK. 
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d) The “Parameters successfully saved” screen will appear.  Press OK. 

 

 Set Wet/Dry Threshold. 

a) This is the trigger point for the meter to know when the sensor is out of the water.   

b) This is important because if the meter does not know that the sensor is under the 

surface of the water, the meter sets the velocity value to zero.   

c) From the Start Menu, select “Setup” and press OK. 

d) Select “Wet/Dry Threshold” and press OK. 

e) Select “Default” (value = 20) and press OK.   

f) If the specific conductivity of the water is very low the flowmeter may not function 

properly.  Document this occurrence in the Fulcrum metadata app and adjust this value 

up or down to troubleshoot.   

g) The “Parameters successfully saved” screen will appear.  Press OK. 

 

 Set Clock. 

a) From the Start Menu, select “Setup” and press OK. 

b) Select “Clock” and press OK. 

c) Follow the instructions to set local time and current date and press OK.   

d) The “Parameters successfully saved” screen will appear.  Press OK. 

e) Update Clock settings to reflect periods of daylight savings time.   

A.4 Preparing to Measure Discharge: Calibrating the Flowmeter  

All flowmeters must be “zero-calibrated” prior to measuring discharge.  The most common 

flowmeter currently at use at NEON aquatic sites is the HACH FH-950.  The following steps detail 

calibration procedures for this model.  If another flowmeter is used for discharge, consult with 

Science regarding calibration instructions.   

 

To calibrate the HACH FH-950 flowmeter: 

 

1. Fill a 5-gallon bucket with water from the stream you will be measuring discharge.  

Using the local water will ensure that the ionic strength of the “zeroing water” is the 

same as the water being measured.  

 

2. Place the velocity meter in the water. Keep the sensor bulb positioned in the center of 

the bucket (or as close to it as possible).  The sensor bulb must be kept a minimum of 3-

inches from the sides and bottom of the bucket as well as the surface of the water.  

 

3. Allow water settle for 1-2 minutes to stabilize.  Water in the bucket must remain still 

throughout the calibration process.   
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4. Turn on the handheld flowmeter and select “Setup”. 

 

5. Select “Velocity Calibration”. 

 

6. Select “Zero Calibration”. 

 

7. Allow the flowmeter to cycle through a calibration reading and, once complete, verify 

that the unit reads a velocity of 0.00 m/s.  Note that -0.00 m/s is acceptable.   

a. If the calibration velocity is 0.00 m/s, return to the main menu on the handheld 

flowmeter. 

b. If the final calibration velocity does not equal 0.00 or -0.00 m/s at the end of the 

calibration cycle (100%), repeat Steps 1-7.  Reasons for calibration errors may 

include: 

i. The sensor bulb tip was touched or is dirty and needs to be wiped off 

with a dry cloth. 

ii. Flowmeter batteries are low. 

iii. The water in the 5-gallon bucket was shifted during the calibration 

procedures. 

iv. The sensor bulb tip was too close to the bucket edges or the water 

surface during calibration procedures. 

c. If, after five attempts, the flowmeter cannot be zero-calibrated, the flowmeter 

should not be used and discharge should not be measured.  Submit a trouble 

ticket and consult with Science.  If possible use another flowmeter to measure 

discharge that can be zero-calibrated. 

 

A.5 Preparing to Measure Discharge: Setting Up the Transect and Delineating Station Spacing for 
Depth and Velocity Measurement 

Discharge measurements at NEON wadeable stream sites are to be measured from the right to 

left bank, looking downstream.  Velocity measurement stations are to begin at the right edge of 

water (REW) and extend to the left edge of water (LEW).   

To ensure high data quality is collected, velocity measurement stations must be spaced correctly 

across the stream discharge transect.  To determine proper station spacing across a transect 

field ecologists must first assess the relevant hydrologic conditions present at the time of the 

discharge measurement; specifically streamflow magnitude, water surface elevation, and 

wetted width.  The overall goal is to establish as many velocity measurement stations as 

possible to obtain a complete and well-distributed velocity profile throughout the cross-section.  

However stations must not be set so close so that subsequent stations measure the same 
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velocity profile.  The location of velocity measurement stations need not be equally spaced 

across the transect.  Rather, the locations should be more closely spaced where water velocity 

and depth are changing most rapidly (this is often at the center of the channel and/or near the 

banks) to ensure that no more than 10% of the total discharge occurs within a single velocity 

measurement station.    

Use the following steps to consider how to best space stations across the discharge transect 

given the dynamic nature of stream conditions within the monitoring location. 

1. Attach the measuring tape to the permanent stake on the right bank and extend it across the 

stream so that is perpendicular to the flow.  Attach the opposite end to the permanent stake 

on the left bank.  

 

2. Assess whether streamflow appears to be relatively uniform across the channel.  Note the 

location of any non-laminar (water is flowing in non-parallel vertical layers) streamflow 

conditions.   

 

3. Measure the wetted width within the transect (the distance between the REW and the LEW) 

and determine station spacing (Table 3).  

a. If the wetted width is >2.00m divide the transect into roughly 20-25 sampling stations.  

Space stations evenly and at wider intervals where flow conditions are homogenous and 

more closely together where flow conditions are non-laminar (Figure 4.  Maintain a 

minimum 0.05m station spacing to avoid duplicate measurements between stations.      

b. If the wetted width is ≤ 2.00m, divide the transect into as many stations as possible 

without duplicating measurements between stations (maintain a minimum 0.05m 

station spacing).  Obtaining 20-25 stations will likely not be possible in very narrow 

streams, in these cases less sampling stations are permitted.  Keep in mind that the 

overall goal is to obtain a well-distributed velocity profile while avoiding duplicate 

measurements between stations.   
 

4. Discharge measured at a single station should not exceed 10% of the total measured 

discharge across the transect.  If non-uniform flow conditions are present (more 

concentrated areas of high flow within the transect), increase the number of sampling 

stations so that a higher number of stations are concentrated along the part of the transect 

with greatest flow (Figure 5).  This will aid in distributing discharge measurements across a 

greater number of stations.   

 

5. Proceed with discharge measurement collection once stations widths have been properly set.   
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Table 3. Station spacing relative to wetted width.   

Wetted 
Width (m)   

Station Spacing 

≤ 2.00 

Divide the transect into roughly 20-25 sampling stations.  Space stations evenly and at wider 
intervals where flow conditions are homogenous and more closely together where flow 
conditions are non-laminar.  Maintain a minimum 0.05m station spacing to avoid duplicate 
velocity measurements between stations.  A single station is not to account for >10% of the 
overall transect discharge.   

> 2.00 

Divide the transect into as many stations as possible without measuring duplicate velocity 
profiles between stations.  Maintain a minimum 0.05m station spacing.  Obtaining 20-25 
stations will likely not be possible in very narrow streams.  A single station is not to account 
for >10% of the overall transect discharge.   

 

 
Figure 4. Example of well-distributed stations across a discharge transect that exhibits laminar flow.  S0-S12 
represent stations and dashed rectangles represent sub-sections.   

 

 

Figure 5. Example of un-even station spacing due to un-even flow distribution across the discharge transect.   

A.6 Measuring Discharge: Proper Techniques and File Setup 

When collecting a discharge measurement in the stream the wading rod is to be held directly in 

front of the operator (at arm’s length) at each station along the transect.  The sensor bulb on 

the flowmeter must be pointed directly upstream into the flow and perpendicular to meter 

tape. 



 Title: AOS Protocol and Procedure: Stream Discharge Date:  10/11/2018 

NEON Doc. #:  NEON.DOC.001085 Author: N.Harrison Revision:  F 

 
 

Page 22 of 73 
 

Do not stand upstream or downstream of the velocity meter but rather to the side (i.e. towards 

the right bank).  Standing directly in front of or behind the flowmeter would create conditions 

that would cause errors in the velocity readings. 

To set up a discharge file on the handheld flowmeter: 

1. Turn the unit on by holding on the ON/OFF button. 

2. In the main menu, select “Profiler” and press OK. 

3. Under “Enter Operator Name”, enter the technician’s name that is collecting the 

measurement and press OK. 

4. Select “Stream” and press OK. 

5. Select “Enter name for Stream” and press OK. 

6. Enter the 4-letter site code for the stream name (i.e. “ARIK”) and press OK. 

a. Note: Special characters, numbers, or any other deviations from the 4-letter site 

code will prevent the discharge file from being uploaded.   

7. Select “Enter Stage Reference” and press OK. 

a. Note: Discharge should not be measured if a staff gauge is either not installed, 

or is displaced at the site.  If a staff gauge is displaced for whatever reason do 

not collect the discharge measurement and write a trouble ticket to Science 

immediately.   

8. Enter the water level on the staff gauge.   

a. Note: During periods of moderate to high flow, waves may be creating 

fluctuating water levels at the staff gauge.  In these instances observe where the 

water level hits the gauge at the highest and lowest crest and record the value 

between those as the stage reference value.  Submit a trouble ticket to Science 

that states that the staff gauge was difficult to read at this time.     

A.7 Measuring Discharge: Collecting Velocity and Depth Measurements 

Once station spacing has been determined, navigate to the first station (01) along the meter 

tape at the right edge of water (REW) to begin the discharge measurement.   Assess whether the 

right bank is undercut or not and follow the appropriate steps to begin the discharge 

measurement.   

How to begin if the right bank is undercut: 

 

1. Enter Edge/Obstruction = “Right”, as this is at the first station, the REW. 

2. Select “Dist. To Vertical” value.   



 Title: AOS Protocol and Procedure: Stream Discharge Date:  10/11/2018 

NEON Doc. #:  NEON.DOC.001085 Author: N.Harrison Revision:  F 

 
 

Page 23 of 73 
 

a. Estimate where the edge of water is located along the meter tape and enter this 

value.  Sometimes it’s helpful to stick your foot or the flowmeter rod under the 

bank to help with this estimate.   

3. Enter a Station Depth of 0.00m and select “Set Depth”.   

4. Note that with a depth of 0.00m entered the flowmeter will not allow you to measure 

velocity.   

5. Scroll down to the screen and select “Next” to measure velocity at the next station. 

6. Place the next station (02) just outside of where the bank meets the edge of water.  

Choose a station location that is close to the bank but allow some space so that the bulb 

of the flowmeter is not touching the side of the bank.  Keep in mind that the velocity 

measured at this location will be extrapolated to the right edge of water.   

7. Continue to Step 3 below to measure velocity at sub-stations across the transect 

towards the left bank.     

 

Setting the first station if the right bank is not undercut: 

 

1. Enter Edge/Obstruction = “Right”, as this is at the first station, the REW. 
2. Enter Edge Factor = “0.75”.  This is the standard edge factor value for all NEON aquatic 

sites. 
3. Select “Dist. To Vertical” value.  Enter the value where the station location falls along 

the meter tape.   
4. Determine the station depth. 

a. Position the base of the flowmeter rod flat on the bottom of the streambed and 
note where the stream surface meets the graduated marks etched into the 
flowmeter rod.   

b. Graduated marks are etched into the flowmeter hexagonal rod to allow for 
water depth measurement. The marks are delineated into 2 cm (one band 
mark), 10 cm (two band marks – the bottom double band), and 50 cm (three 
band marks).  

c. Water depth measurements should be rounded to the nearest 1 cm.  

d. If needed, practice this step prior to collecting the discharge measurement in 
order to familiarize yourself with the increments.    

e. If the bank angle is negligible at the water’s edge then the depth is typically 
zero, as this is the point where the water meets the surface.  A depth of 0.00m 
should then entered and velocity cannot be measured.  If this is the case press 
OK and proceed to the next station.    

5. Select “Set Depth” to enter the depth value at the station.   

6. Select “Measure Velocity” (if depth >0.00m) and press OK. 
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7. Determine Velocity Point Method: one-point (60%), or two-point (20% and 80%) (Table 

4) 

a. If station depth is <0.45m, collect a one-point velocity measurement at 0.6 of 
the depth below the surface.  This velocity measured at this point of the water 
column is assumed to equal the mean velocity within the sampling station.   See 
A.5.2 for instructions on setting the flowmeter rod to the appropriate depth. 

b. If station depth is >0.45m, collect a two-point velocity measurement at 0.2 and 
0.8 of the depth below the surface.   The average of these two measurements in 
assumed to equal the mean velocity within the sampling station.  See A.5.2 for 
instructions on setting the flowmeter rod to the appropriate depth. 

 One-point (60% depth) and two-point (20% and 80% depth) 
measurements are relative to the stream surface equaling 0m.   

 For example, if station depth = 0.50m, the first of the two-point velocity 

measurements (0.2 depth) would be collected 0.10m below the water 

surface, or 0.40m above the streambed.  The second of the two-point 

velocity measurement (.8 depth) would be collected 0.40m below the 

water surface, or 0.10m above the streambed.   
 

Table 4. Velocity point methods are based on station depth.   

Stream Depth at  
Measurement Location 

Velocity Point Method  

< 0.45 meters One point - 60% of Depth 

≥ 0.45 meters Two point - 20% and 80% of Depth 

 

8. Select “One Point” or “Two Point” Velocity Method depending on depth. 

9. Set the wading rod to appropriate depth. 

10. The wading rod must be adjusted in order to set the velocity meter at the correct depth 

in the streamflow (Figure 6). The round sliding rod (located behind the hexagonal rod) is 

used to set the measurement depth and is scaled with 0.10m graduations from top 

(0.00m) to bottom.  A smaller scale on the handle of the hexagonal fixed rod is used to 

fine-tune the depth, and is scaled with 1 cm graduations (0 to 10cm).   

 

11. Listed below are three examples on how to collect velocity measurements at desired 

depths on the wading rod. Refer to Section A.5.2 to determine the amount and locations 

of velocity measurements required for various water depths in the field.    

a. One-Point Velocity Method: 60% Depth, Station Depth = 0.36m 

 The one-point velocity method requires no calculations by the user.   
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 Line up the 3 on the sliding rod (represents 0.30m total station depth) with 

the 6 on the handle of the fixed hexagonal rod (represents 0.06m total 

station depth). Coupled, these two settings set the flowmeter at 60% of 

station depth 0.36m.   

b. Two-Point Velocity Method: 20% Depth, Station Depth = 0.72m 

 Multiply the station depth by two (0.72 * 2 = 1.44 m) and round to the 

nearest centimeter (1.44).  Line up the 14 on the sliding rod (represents 

1.40m of the total station depth) with the 4 on the handle of the fixed 

hexagonal rod (represents 0.04m of total station depth).  Coupled, these 

two settings set the flowmeter at 20% of the station depth at 0.72m.    

c. Two-Point Velocity Method: 80% Depth, Station Depth = 0.72m  

 Divide the station depth by two (0.72 / 2 = 0.36 m) and round to the nearest 

centimeter (0.36).  Line up the 3 on the sliding rod (represents .30m of the 

total station depth) with the 6 on the handle of the fixed hexagonal rod 

(represents 0.06m of the total station depth).  Coupled, these two settings 

set the flowmeter at 80% of station depth 0.72m.   

 

 

 

Figure 6. Wading rod adjustments at 60% (one-point), and 20% and 80% (two-point) depths. 
Station depth = 0.72m.   
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12. Once the flowmeter has been set to the correct depth and the correct velocity method 

has been selected, select “Capture” on the handheld flowmeter to begin measuring 

velocity.   

13. The screen will display a graph showing the instantaneous values and the progress of 

the reading.   

14. If velocities appear to be inaccurate or are fluctuating > ±5%, repeat the reading.   

15. If repeated velocity values seem inaccurate or are fluctuating >5% during the 

measurement collection, consider the following causes: 

a. Streamflow is turbulent.  Increase the Fixed Period Averaging Time to 60 
seconds in the Filter Parameters settings (See SOP A3 Step 4).   

b. There is an obstruction immediately upstream or downstream of the station 
location.  Move the station location so that is not directly above or below the 
obstruction and try another velocity measurement. 

c. Flowmeter was not calibrated correctly.  Re-calibrate flowmeter and start 
discharge measurement over. 

d. Flowmeter is low on batteries.  Replace batteries in flowmeter and repeat 
measurement. 

e. If you cannot diagnose the source of the problem, continue discharge 
measurement and submit a trouble ticket explaining the issue. 

f. Once the measurement has been completed (minimum 40 seconds) press OK to 
save data and move to the next station location. 

16. Move to the next station location and repeat Steps 3-16.  Note that you will not need to 

enter an Edge value as these stations should be in open water environments (not along 

the edge of a bank or near an obstruction). 

17. If the left bank is undercut, place the second to last station should be located just 

outside of where the left bank meets the edge of water.  Choose a station location that 

is close to the bank but allow some space so that the bulb of the flowmeter is not 

touching the side of the left bank.  Keep in mind that the velocity measured at this 

location will be extrapolated to the left edge of water.   

18. If the left bank is undercut follow the steps below to set the final station: 

a. Enter Edge/Obstruction = “Left”.  

b. Select “Dist. To Vertical” value.   
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c. Estimate where the left edge of water is located along the meter tape and enter 
this value.  Sometimes it’s helpful to stick your foot or the flowmeter rod under 
the bank to help with this estimate.   

d. Enter a Station Depth of 0.00m and select “Set Depth”.   

 Note that with a depth of 0.00m entered the flowmeter will not allow 
you to measure velocity.   

e. Proceed to Step 20.   

19. If the left bank is not undercut follow the preceding steps below to measure velocity at 

the left edge of water, if possible.   

a. Enter Edge/Obstruction = “Left” 

b. Select “Dist. To Vertical” value.   

c. Enter a Station Depth (enter 0.00m if the bank angle is negligible). 

d. Measure velocity (if possible).   

20. Once the LEW station has been completed, select “Summarize Collection and Save 

Data”. 

a. Observe “Channel Summary” and verify that units are in liters/second. 

b. Select “Save Data and Exit”.  This is a critical step as all data will be erased if this 
is not completed. 

c. Enter “Name of File”. 

d. Use a unique file name to delineate discharge measurement in the following 
format “XXXXMMDD” where: 

e. XXXX = 4-digit site ID (i.e. “GUIL”) 

f. MMDD = Year, Month, Date of measurement 

g. Example: “GUIL0927” 

 The flowmeter only allows 8 characters to be used for each filename 
which makes it not possible to enter the year of the measurement.  As 
such, at the end of each calendar year delete all measurement files on 
the flowmeter, only after ensuring that each file on the flowmeter has 
been properly saved on the AOS dropbox and uploaded onto the SOM 
portal. 
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A.8 Evaluating the Discharge Measurement 

The discharge measurement must be evaluated once the measurement has been 

completed.  A thorough evaluation must include the following components: 

 

1. Check for data entry errors; 

2. Check the total percentage discharge collected at each station; 

3. Compare the total measured discharge to the predicted value from the rating curve (if 

available) 

 

1. Check for data entry errors 

 

Review the discharge measurement file for data entry errors.  In addition to negatively 

affecting data quality, certain errors in the discharge file will prevent the file from being 

uploaded.   

 

Verify that: 

 

 The station (or location) values are increasing from the right (first station) to left 

edge (last station). 

 Depth values were entered correctly (i.e. check decimal points, “0.8” instead of “8”) 

 Depth value at a given station is less than 10 times greater than the preceding 

station. 

a. If this error occurs than stations were likely set too far apart in the transect.  

Additional velocity measurement should be collected between set stations.   

b. Other than at the left/right edges, zero depth values (0.00m) should not be 

present within the discharge transect.  If this is the case the transect should 

be moved upstream or downstream to a cross-section where water is 

flowing uniformly (more or less) across the transect.  Submit a trouble ticket 

if the discharge transect was temporary re-located to facilitate these 

conditions.    

 The stream profile name was entered correctly (4-digit site code). 

 The stage reference value was entered correctly. 

 All units were set correctly. 

 The filter parameter was set correctly in flowmeter settings ( minimum 40 seconds). 

 

2. Check the total percentage of discharge collected at each station 

 

NEON uses the mid-section method to compute stream discharge.  In this method, the 

transect is divided into rectangular sub-sections.  The sub-section area extends laterally 
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from half the distance from the proceeding station to half the distance to the next station.  

The width of the sub-section (variable across the transect) is calculated by subtracting the 

distance to the previous station from the distance to next station, then dividing by 2.  The 

area of the sub-section is the width of the sub-section times the depth of each station.  

Discharge per station equals the sub-section area times the measured velocity.  The total 

discharge is the summation of the discharge all each stations.    

 

Certain flowmeter models automatically calculates discharge per station and total discharge 

per measurement.   Ideally, no more than 5% of the total measured discharge should be 

measured within a single station, but this can be difficult to achieve in small streams with 

narrow or irregular channels.   

 

In general, no more than 10% of the total measured discharge should be measured within a 

single station. Following the discharge measurement, check the file to verify that this has 

not occurred (if possible given the make and model of the flowmeter).   

 

If it is observed that >10% of the total discharge was measured in one or more stations:  

 

 If >10% of the total discharge was measured in one or more station in streams with 

a wetted width ≤ 2m: 

 Reduce the station spacing (minimum 0.05m) in areas with more 

concentrated flow.  

 If >10% of the total discharge was measured in one or more station in streams with 

a wetted width > 2m: 

 Reduce the distance between stations by increasing the number of stations 

within the discharge transect.   

 Reduce the station spacing (minimum 0.05m) in areas with more 

concentrated flow.  

If, despite these attempts, >10% of the total discharge is still collected in more than one 

station, save and upload the discharge measurement and submit a trouble ticket in order to 

consult with Science.  Again, this requirement may be very difficult to achieve in narrow or 

irregularly-shaped channels.   

3. Compare the total measured discharge to that predicted by the stage-discharge rating 

curve (if available). 

 

Once a stage-discharge rating curve has been developed for a site, a rating equation is 

derived that predicts discharge given stream stage (Figure 7).  Once established, rating 



 Title: AOS Protocol and Procedure: Stream Discharge Date:  10/11/2018 

NEON Doc. #:  NEON.DOC.001085 Author: N.Harrison Revision:  F 

 
 

Page 30 of 73 
 

equations will be provided to FOPs by Science.  Rating equations are commonly expressed 

as power relationships: 

Q = Cr(G – α)β 

Where: 

Q = discharge; 

G = the stage, or gauge height; 

α = the gauge reading corresponding to zero discharge; and 

Cr and β = rating curve constants 
 

Following the discharge measurement, enter the stream stage (G) into the rating equation 

that is associated with the site and calculate predicted discharge.  Evaluate whether the 

discharge (just measured) is ±10% of the discharge predicted by the equation.  If the 

measured discharge is >±10% that predicted and the stream stage has not changed, collect 

another measurement immediately.  If, after a second attempt, the measured discharge 

remains >±10% the predicted rating discharge, upload both measurements and submit a 

trouble ticket to Science.  This may indicate a shift in the rating, which, if validated by 

additional measurements, would warrant an increase in the frequency of discharge 

measurements at the site.   
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Figure 7. Example of stage-discharge rating curve. Circles indicate discharge measurements collected across a wide 
range of gauge heights.  Rating equations for each of the three distinct segments are shown representing low, 
medium, and high flow regimes.  In this example, a section control governs the stage-discharge relationship during 
the low-flow regime and the main channel control becomes de-activated at higher stages when as the streamflow 
tops the banks.  Once flow exceeds the channel capacity the stage-discharge relationship is governed by floodplain 
channel control.   

 

Breaks in the slope of the rating curve are often associated with one control becoming 

submerged and another becoming activated.  Three types of controls are common in natural 

streams, each of which depend on streamflow and channel conditions (Figure 8) (Braca 2008).   

 

1. Section Controls: a natural downstream feature such as a riffle, rock ledge, sand 

bar, or severe channel restriction that tends to control the low-flow regime.  As 

gauge height increases with higher streamflow the section control becomes 

submerged in such a way that it no longer controls the relation between gauge 

height and discharge.    
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2. Channel Controls: a combination of downstream features throughout the reach 

such as channel size, shape, curvature, slope and roughness.  The length of channel 

controls can be extremely variable.  Channel controls typically govern stage-

discharge relations during periods of higher streamflow. 

 

3. Combination of Section and Channel Controls: at some stages, the stage-discharge 

relation may be governed by a combination of section and channel controls.  This 

usually occurs during a short range in stage between section-controlled and 

channel-controlled segments of the rating curve, or the transition zone.  Channels 

with unstable controls tend to exhibit section/channel combinations.  

 

 

Figure 8. Schematic representation of control range in a rating curve.  (Illustration: Braca 2008) 

 

A.9 Ending the Sampling Day 

After each discharge survey the velocity meter, wading rod, and waders shall be cleaned following 

standard operating procedures for cleaning field equipment used in aquatic systems.   Batteries for 

the velocity meter shall be charged or replaced as applicable.    

 

SOP B Data Entry and Verification 

There are no field data sheets for this protocol.  Electronic data should be uploaded to the appropriate 

location within seven days of collection.  However, given logistical constraints, the maximum timeline 

for entering data is within 14 days of collection or the end of a sampling bout (where applicable).  See 

RD[04] for complete instructions regarding manual data transcription. 
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Extract stream discharge data from the digital meter to a local computer using the correct cable type 

(e.g., a USB to micro-USB cord).  

 Refer to the velocity meter’s manual to locate the USB connection port.  Plug the correct 

ends of the connection cord into the display unit and the computer.  

8. Turn the velocity meter on.   

1. A “PVM Drive” should appear on the computer screen. 

2. Locate the utility via My Computer.  Two folders should be present: P and RT. 

Select the “P” folder.   

3. Note: if a dialog box appears asking to format the drive, close the window.  DO 

NOT format the drive. 

9. Select the appropriate file to transfer (e.g., POSE0930.TSV). 

10. Copy the file to the computer. 

11. Rename the file if needed. 

12. Re-check the discharge files for potential errors as described in SOP A.8.   

13. Upload one copy of the discharge file onto the AOS Dropbox in the appropriate folder. 

14. Upload an additional copy of the discharge file onto the SOM/WebUI Portal. 
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APPENDIX A QUICK REFERENCES 

Step 1 – Ensure that all supplies and necessary field gear is packed. 

Step 2 – Ensure the Field Metadata and Gauge Height table is completed per field site visit in the 
Fulcrum app. 

Step 3 – Navigate to the sampling location and divide the stream up into subsections according the 
channel wetted width and streamflow conditions within the transect: 

 A single station should not account for >10% of the overall measured discharge.  This can 

be difficult to achieve in narrow channel types.   

Step 4 – Delineate the correct station width and/or count based on the wetted width.  

 

Table 3. Station spacing relative to wetted width. 

Wetted 
Width  

Station Spacing  

≤ 2.00m 

Divide the transect into roughly 20-25 sampling stations.  Space stations evenly and at 
wider intervals where flow conditions are homogenous and more closely together where 
flow conditions are non-laminar.  Maintain a minimum 0.05m station spacing to avoid 
duplicate velocity measurements between stations.  A single station is not to account for 
>10% of the overall transect discharge.  Sample every 0.1 m, or 0.05 m if there is  >10% 
of the flow in any one subsection 

> 2.00m 

Divide the transect into as many stations as possible without measuring duplicate 
velocity profiles between stations.  Maintain a minimum 0.05m station spacing.  
Obtaining 20-25 stations will likely not be possible in very narrow streams.  A single 
station is not to account for >10% of the overall transect discharge.  20 – 25 sampling 
locations, or increase the number of sampling stations if > 10% flow, flows through any 
one subsection. 

Step 5 – Determine if a one point (60%) or a two point (80% and 20%) velocity method is required per 
station.   

  Table 4. Velocity point methods are based on station depth. 

Station Depth Velocity Point Method 

< 0.45 meters 1 point - 60% of Depth 

≥ 0.45 meters 2 point - 20% and 80% of Depth 

Step 6 – Set up the measurement transect. 

Step 7 – Zero-calibrate the velocity meter.   
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Step 8 – Measure velocity and depth at each station along the transect.   

Step 9 –Calculate total discharge with the handheld flowmeter.   

Step 10 – Review file for potential data entry errors and % total discharge per station.   

Step 11 – Save data. 

Step 12 – If a stage-discharge rating curve is available, insert the stage value into the appropriate rating 

equation and evaluate observed vs. predicted discharge values.  If predicted discharge is > ±10% of 

observed and the stage has not changed, collect another discharge measurement.   

Step 13 – Decontaminate equipment. 

Step 14 – Recharge or replace batteries in the velocity meter. 

Step 15 – Upload discharge measurement file onto the AOS Dropbox and the SOM portal.   
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APPENDIX B RIVER DISCHARGE  

B.1 Introduction 

An acoustic Doppler current profiler (ADCP) uses sound to measure water velocity based on the Doppler 

effect, a principal of physics discovered by Christian Johann Doppler in 1842.  Doppler’s principal relates 

the change in frequency of a source to the relative velocities between the source and the observer.  An 

ADCP applies the Doppler principle by reflecting an acoustic signal off small particles of sediment and 

other material (scatterers) that are present in water.  The velocity measured by the Doppler principle is 

parallel to the direction of the transducer emitting the signal and receiving the backscattered acoustic 

energy.   

NEON utilizes an ADCP to measure discharge at NEON aquatic sites that contain rivers.  The 

ADCPcontains five beams pointed at 20 degrees from the vertical.  NEON river discharge measurement 

collection involves mounting the ADCP off the side of a piloted motor boat (a boat driver and crew are 

situated inside the boat moving it across the channel) so that it is deployed beneath the water surface, 

aiming downward.  Discharge and velocity calculations performed by ADCPs during streamflow 

measurements are well-documented in the literature (Mueller et al., 2013; TRDI, 2015) but the basic 

premise is as follows (Den Herder, 2018): 

 The ADCP instrument transmits short pulses of sound at fixed frequencies into the water. 

 The transmitted sound bounces off scattered material suspended in the water (sediment, 

microscopic organisms, etc.).  The returned signals from these scatterers are shifted in 

frequency. 

 The returned signals from each beam are used to create the water currents in east, North, and 

Vertical velocity vectors. 

 Returned signals are continuously processed into separate depth cells (or bins) to provide a 

profile of the water column  

 Binned velocity and depth are integrated to calculate bin discharge, which are then summed to 

calculate total discharge  

 Multiple discharge transect measurements are completed and mean discharge across transect 

measurements is calculated and reported as total discharge. 

The ADCP measures the relative motion of the water to the ADCP by correcting the measured water 
velocity with the measured boat velocity.  The velocity of the boat can be calculated in two ways:  
externally via a global positioning system unit (GPS), or internally utilizing ADCP bottom tracking 
technology.  The ADCP divides the water column into depth cells (or bins) and reports a velocity for each 
depth cell.   
 
The ADCP software integrates total bin velocity over the bin depth to obtain bin discharge.  The resulting 
sub-section discharges are then summed over the width of the cross-section to obtain total measured 
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discharge for each transect.  Certain areas within the channel cross-section profile cannot be measured 
by the ADCP (at the water surface due to draft and flow disturbance around the instrument, near the 
channel bed due to side-lobe interference, and near each bank due to shallow depths).  These areas 
must be estimated by the ADCP software.  Discharge in the unmeasured upper and lower portions of the 
cross-section are typically estimated using a one-sixth power-curve estimation scheme while discharge 
in the unmeasured portions of the cross-section near the bank edges are estimated using a ratio-
interpolation method (Simpson, 2001). Total river discharge is the sum of the total channel discharge 
(the sum of all discharge bin values calculated during the discharge measurement transect), the near-
shore discharge measurement on the left side of the channel and the near-shore discharge estimate on 
the right side of the channel.  The total discharge associated with the measurement is the mean 
discharge of all transects conducted during the sampling bout.  On average it expected to take 1-2 hours 
to complete a river discharge measurement from start to finish.   
 

B.2 Required Equipment and Materials 

A pre-field inspection checklist is required in order to ensure all necessary items are available for the 

discharge measurement (Table 5).  Before leaving the office check all cable connections, run ADCP 

diagnostics, check GPS-ADCP integration, and inspect all equipment for potential defects.    

 

Table 5. Equipment list – Field equipment for river discharge measurement. 

Supplier Supplier # R/S Description Purpose 

Q
u

an
ti

ty
 

Sp
e

ci
al

 
H

an
d

lin
g 

Durable items 

Teledyne 
Marine 

 

R 

Fully charged laptop with 

WinRiver II and Q-View software 

installed. Software download 

available: 

http://www.teledynemarine.co

m/rdi/support 

Interfacing with ADCP 1 Y 

Teledyne 
Marine 

 
R RiverPro ADCP Measuring streamflow 1 Y 

Teledyne 
Marine 

 
R ADCP to PC serial-USB cable 

Connects ADCP to 12V battery 
and PC 

2 Y 
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Supplier Supplier # R/S Description Purpose 

Q
u

an
ti

ty
 

Sp
ec

ia
l 

H
an

d
lin

g 

 

 

R Trimble to PC serial cable set 

Trimble/9-pin male to 9-pin 
female/9-pin female (available 
from Compass Tools) to RS-
232 male/USB  

1 Y 

Compass 
Tools 

88180-04 
R 

Fully charged Trimble with 

NMEA GPS output activated 
Provides GPS referencing for 
ADCP  

1 Y 

Compass 
Tools 

 
R 

Trimble Tornado antennae 
w/cable and pole 

Increases Trimble GPS 
precision 

1 Y 

 
 

R Zipties or Velcro straps  
Connects Tornado pole to 
ADCP mount 

1 N 

 
 

R Silicate lubricant for ADCP cable 
Lubricates and protects ADCP 
cable 

1 N 

 
 

R 
ADCP mount and tools and 
associated hardware (NEON-
fabricated) 

Adjusting ADCP mount 1 N 

  R Allen wrench set Adjusting ADCP mount 1 N 

  R Charged 12V 7AH battery Powers ADCP 2 Y 

  R Thermometer (reads in C°) Measures water temperature 1 Y 

  R Anemometer Measures wind speed 1 Y 

 
 

R Laser rangefinder 
Measures distances from boat 
to shore 

1 Y 

  R Meter tape or metric ruler Measures ADCP depth 1 N 

 
 

R Flagging 
Marks general location of start 
and stop end points at banks 

1 N 

  R Sharpie Marks flagging 1 N 
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Supplier Supplier # R/S Description Purpose 

Q
u

an
ti

ty
 

Sp
ec

ia
l 

H
an

d
lin

g 

 
 

R Anchored floats (non-magnetic) 
Precisely mark start and stop 
end points in the water 

2 Y 

  S Boat anchor  Holds boat in fixed position 1 N 

 
 

R Shrink warp and heat gun 
Protects serial cable 
connections in wet weather 

1 N 

 
 

R Laptop cover or umbrella 
Protects laptop in wet 
weather 

1 N 

 
 

S Laptop shade 
Shades computer screen so it 
can be easily read in bright 
weather 

1 N 

  R USB flash drive Backs up measurement files 1 Y 

 
 

R 
River discharge protocol and 
laminated TRDI protocol cards 

Can be referenced during 
discharge measurement 

1 N 

 
 

R 
All necessary safety supplies and 
PPO for operating the boat 

Safety NA Y 

B.3 Methods: Pre-Measurement Setup 

Perform the following steps in preparation for the discharge measurement. 

1. Assemble the ADCP mount on boat.  Reference directions supplied by Engineering (HJ13710000 

in ECO-05389).   

2. Carefully affix ADCP into ADCP mount. 

a. Adjust the mount depth so that the base of the ADCP is fully submerged.  Take care not 

to lower the ADCP too far into the water column as this increases the unmeasured area 

at the top of the profile and creates drag that negatively impacts measurement.   Ensure 

that the ADCP is low enough to be clear of any protuberances in the base of the hull 

which could affect the velocity profile near the top of the water column.     

b. Allow the ADCP transducers to be submerged in the water for at least 5 minutes prior to 

discharge measurements in order to sufficiently equilibrate to the water temperature.  

Failure to do so will impact measurement accuracy.   

3. Place the thermometer into the water to begin collecting a temperature measurement.   
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4. Turn on the Trimble and connect the Tornado antennae to the handheld receiver in order to 

begin acquiring satellites.  

5. Attach the Tornado antennae pole directly above the vertical beam of the ADCP mount using 

zipties or Velcro straps.  Mount the Tornado antenna as close to the center of the ADCP as 

possible.  Ensure that it will remain stable during discharge measurement.   

6. Open WinRiver II software – Q-View software should automatically initialize.  If not, open Q-

View as well.     

B.4    Methods: ADCP Serial Connections Setup 

Perform the following steps to connect the ADCP to the PC and validate the connection.  Use the 

WinRiver II Serial Communications Setup Card for an additional reference regarding quick instructions 

on setting up the ADCP within the software.   

1. Ensure that all ADCP serial cables are present and properly connected (Figure 9).  

2. Remove the black cover plug and connect the ADCP serial cable to ADCP (make sure it is lightly 

lubricated).  Connect the cable to the instrument so that the Teledyne logos are matched up.   

3. Attach RS-232 cable to the other end of the ADCP serial cable and connect the USB end of the 

RS-232 to a laptop port. 

4. Verify which serial COM port the RS-232 is in using Device Manager. 

5. Connect the ADCP serial cable terminal ends to a fully charged 12V 7AH battery. 

6. Open WinRiver II software. 

7. On the top taskbar select Configure > Peripherals. 

8. Click the “+” node next to Read Serial Raw ADCP Data. 

9. Highlight Port and select Configure. 

10. Verify that the COM Port listed is the same that the RS-232 cable is connected to (Step 3) and 

that the following settings are listed: 

a. Baud Rate: 115200 

b. Databits: 8 

c. Parity: None 

d. Stopbits: 1  

11. Once these settings have been entered, click OK. 

12. Click Test Port, the ADCP wakeup message should appear in the dialogue window.  The 

appearance of this message verifies that the ADCP is connected to the software.   

13. Click Close to exit Configuration settings. 

 

 

Figure 9. ADCP to PC serial cables.  Make sure that an RS-232 adapter (blue and white 9-Pin 
male to USB with FTDI driver) is included in this set.  Also included are the 12V batter 
connectors (red and black clamps) as well as the cable that connects to the ADCP (black covered 
cable with a loop on the end). 
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B.5 Methods: Trimble GPS Receiver and Tornado Antennae Setup 

Perform the following steps to configure Trimble settings, connect the Trimble to the PC and validate 

the connection. 

1. Verify that the Trimble is powered on, connected to the Tornado receiver and that a reasonable 

number of satellites have been acquired relative to environmental conditions.   

2. Verify that each of the Trimble serial cables are present and properly connected (Figure 10). 

 

 

Figure 10. Trimble to PC connection serial cables.  This set contains three cables that must be attached: 
the Trimble to 9-pin (male); the 9-pin (female) to 9-pin (female); and the RS-232 9-pin (male) to USB. 

 

3. Set Trimble time to UTC.   

4. Verify that NMEA output is activated (Figure 11). 

a. Click the Start button > Settings > System > System Information. 

b. Click on the arrow to the right of “Device” on the gray header bar. 

c. Navigate to “Options”.  Confirm that NMEA output has been activated. 
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Figure 11. Verify that NMEA output is activated on the Trimble receiver.   

 

5. Open the TerraSync application.  

6. Go to Setup. 

7. Click on “GNSS settings”. 

8. Set NMEA Output to ON.  Verify that NMEA output is set to COM3.   

9. Click on the wrench button. 

10. Check all General settings (GGA, VTG, etc.) 

11. Click Done 

12. Go to Settings.  

13. Click the GNSS button (top right) to make sure that the GNSS receiver is activated. 

14. Connect the Trimble to the laptop COM3 serial port using the cable setup described in Table 5 

and Figure 10.  Mimic the setup illustrated in Figure 12.   
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Figure 12. Proper setup of the Trimble receiver using the three serial cables  

connected together. Note that the Tornado antennae is not attached in this example.   

 

15. Verify that the Trimble RS-232 cable (Figure 12) is in the COM3 port of the laptop using 

Windows Device Manager. 

a. Note that it may be necessary to change the assignments of COM ports on the PC so 

that COM3 is available for the Trimble.   

b. If the Trimble is not assigned to COM3: 

i. In the Windows Device Manager, under the Ports node, determine which COM 

port the Trimble is assigned to (this can be done by attaching and re-attaching 

the USB into the PC). 

ii. Right click on the COM port and select Properties. 

iii. In the Properties window, switch to the Port Settings tab and click on 

the “Advanced” button. 

iv. In the Advanced Settings window, choose COM3 from the COM Port Number 

dropdown (lower-left corner of the window).  If COM3 is not available, go back 

to the Device Manager and re-assign whatever device is using COM3 a different 

COM port number.     

v. Once the Trimble has been assigned to COM3, click OK to save settings.  You 

may need to remove and re-attach the Trimble USB for the new settings to take 

effect.   

16. Verify that COM Port latency settings are set to the lowest level. 

a. In the Windows Device Manager right-click on the port that the Trimble is assigned to 

(COM3) and select “Properties”. 

b. Click on the “Port Settings” tab. 

c. Click the “Advanced” button. 

d. COM Port Number should be set to COM3. 
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e. Under “BM Options”, set the Latency Timer to 1 msec.   

17. Open WinRiver II.  In the main screen, click Configure > Peripherals.  

18. Under the Peripherals node, click ADD. 

19. Under Devices node select GPS. 

20. Double click on “Read NMEA GPS Data”. 

21. Set: 

a. Comm. Port: COM3 

b. Baudrate: 9600 

c. Databits:8 

d. Parity: NONE 

e. StopBits: 1 

22. Select OK. 

23. Open GPS Serial Port 1 Node in Peripheral Configuration Dialogue. 

24. Click Test Port. 

25. You should see some GPS data appearing on the emulator screen.   

a. Ex: $GPGGA,,,,,,,,*56<LF> or actual GPS locations (if there are satellites available). 

b. GPS data being logged in this terminal window confirms that the Trimble is exporting 

NMEA GPS output and is recognized by WinRiver II software.   

26. Click Finish.  The GPS data will be recorded in the raw data file. 

27. Leave the TerraSync application open on the Trimble throughout the discharge measurement.   

B.6 Methods: Starting a New Measurement in WinRiver II 

1. Set laptop system time zone to UTC.   

2. In the WinRiver II main screen, click Configure > Units > All SI to set units to metric.   

3. In the WinRiver II main screen, click File > New Measurement to run the Measurement Wizard. 

4. Fill in all information in the Site Information tab. 

a. Station Number: this is arbitrary and not really applicable to NEON, “01” is OK  

b. Measurement Number: The sequential discharge measurement number for the site 

c. Agency: NEON 

d. District: this can be left blank 

e. Hydrologic Unit: 14 (River) 

f. Field Party: Initials of all crew involved in measurement 

g. Processed By: Initials of technician operating the WinRiver II software and evaluating 

data collection 

h. Deployment Type: Manned Boat 

i. Boat/Motor: Unique ID for boat used 

j. Meas. Location: if measured at the regular discharge cross-section enter “DSC1”, if 

measured at a different cross-section within the site denote that with a different code 

here, like “DSC_US” if the cross-section is upstream of the regular location.  Make sure 

to also include field notes that describe this occurrence if this is the case 

k. Grid Reference: can be left blank 
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5. Select the “Rating Information” tab on the left. 

a. Inside Gage Height: water level measurement on inside of staff gauge 

b. Outside Gage Height: water level measurement on outside of staff gauge (most likely 

the same as the Inside Gage Height) 

c. Rating Discharge: predicted discharge given gauge height from rating curve, if available 

d. Index Velocity: can be left blank 

e. Rated Area: can be left blank 

f. Rating Number: can be left blank 

g. Water Temp: the water temperature measured using a thermometer submerged in the 

water for at least 5 minutes 

i. The measured water temperature should be within 2 degrees of the ADCP 

temperature measurement. 

ii. In general ADCP temperature measurements do not drift until there is a major 

issue.  If this does occurthe ADCP-measured temperature will deviate greatly 

from the thermometer measurement.  If this is the case make a note in the 

measurement note window and contact Science following the measurement 

bout. 

h. Tail Water Level: can be left blank 

i. Magn Variation Method: Model 

j. Measurement Rating: fill this out at the end of the measurement based on your 

judgment of the measurement quality 

k. Control Codes: select all (if any) that apply to the measurement 

l. Wind Speed: measured wind speed using an anemometer 

m. Wind Direction: measured wind direction using an anemometer 

i. If the anemometer does not provide a direction measurement enter: 

 Upstream: if the wind is blowing up river 

 Downstream: if the wind is blowing down river 

 Cross-wind: if the wind is blowing across the river 

 Mixed: if the wind is not blowing in any particular direction 

n. Edge Method: method used for determining bank distances (i.e. laser rangefinder, 

meter tape, etc.) 

6. Select the “Configuration Dialogue” tab on the left. 

a. Ensure that the ADCP (RiverPro) is recognized by the software.   

i. The button next to “ADCP” will turn green once the “interrogating the ADCP” 

window closes.  This means that the ADCP has been successfully recognized by 

the software.   

ii. If the button next to “ADCP” is red this indicates that communications are not 

properly set up and the software does not recognize the ADCP.  Reference 

Section 3.1.1 to ensure that all steps were followed correctly.   

 Ensure that the “RiverPro” is present in the dropdown box. 
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 Check that serial cables are connected properly and the laptop COM 

port that the RS-232 is connected to matches that the software thinks 

that it is in.   

 The ADCP must be recognized by the software for the discharge 

measurement to be conducted.   

b. Once the ADCP has been recognized (green light shown) click the External GPS Box. 

i. The green light indicates that the external GPS (Trimble) is recognized by the 

software. 

ii. An error message will be produced if the GPS is not responding to the 

communications test.   

 This has been noted as a common occurrence.   Press OK to check and, if 

necessary, re-configure the Communication settings.  Press OK again.  

This is a known solution to enabling WinRiver II to recognize the 

Trimble. 

 If the software still fails to recognize the Trimble: 

a. Check that all cables are securely connected. 

b. Check COM port latency settings in Windows Device Manager. 

c. Check the COM port settings on both TerraSync and WinRiver II. 

d. Check that NMEA output is set to ON in TerraSync. 

e. Re-test Port in Peripheral settings.   

f. If GPS is unable to be integrated with the software the 

discharge measurement should still be conducted.  Document 

this occurrence in measurement notes and report the issue to 

Science.   

i. To add a note to the measurement file, right-click Site 

Information on the Measurement Control window.  

Enter all notes into Remarks section.   

c. Depth Sounders and External Headings are not used and can be ignored. 

d. Under Offsets: 

i. Enter Transducer Depth. 

 Measure from the water level to the center of the slant in the 

transducer faces with a ruler or metric tape.   

 This is a very important measurement!  Repeat it two or three times to 

ensure accuracy.   

 When operating the boat make sure everyone is not standing on one 

side which may cause the boat to tilt and skew the transducer depth.  

Even weight displacement in the boat should be maintained throughout 

all transect measurements.     

ii. Enter Magnetic Variation, the angle of declination relative to your location in 

the world.    
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 For greatest accuracy, check the National Geophysical Data Center 

website to find the declination angle based on your latitude and 

longitude (https://www.ngdc.noaa.gov/geomag-web/#declination) 

 Some examples: 

a. Longmont, CO:  8° 21’ E (8.21) 

b. Coffeeville, AL:  2° 22’ W (2.22) 

c. Newton, GA: 4° 47’ W (4.47) 

d. Arcata, CA:  14° 26’ E (14.26) 

e. ADCP Wizard Configuration or Discharge values do not need to be entered when using 

the RiverPro ADCP.  

7. Select the “Output Filename Options” tab on the left. 

a. Enter correct Station name for Filename Prefix (i.e. “TOMB”). 

b. Select Output Directory where the measurement will be saved on the laptop.   

c. Select Long Date/Time in Filename. 

8. Select the “Summary Page” tab on the left (“Command Preview” can be skipped for RiverPro 

units). 

a. Review all information to ensure that is correct.  

b. Ensure that green checks are present for ADCP and GPS communications. 

c.  Click the Finish button to complete wizard. 

9. Open Q-View. 

a. If the dialogue window is not already present in the lower right hand of the WinRiver II 

screen, open the software manually by either searching for it in the Start menu or the 

“Show hidden icons” carrot on the right side of the taskbar (by the battery level 

indicator). 

b. Click on the Procedure box. 

c. Ensure that all Procedure rows are checked green other than “ADCP test completed and 

passed”, “Moving bed tests done and valid”, and “Minimum 2 transects” – those will still 

have red checks as these procedures have not been completed yet.    

i. Review the measurement wizard to fill in any missing information. 

B.7 Methods: Pre-Measurement QAQC  

The following QAQC protocols are critical to quality data collection and must be initiated prior to the 

first transect measurement of each discharge bout..   

The following procedures are outlined below: 

 Set the ADCP clock 

 Execute an ADCP test 

 Test the pressure transducer 

 Calibrate the compass 

 Enter magnetic variation correction value 

 Perform a moving bed test and assess moving bed test summary 
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 Configure the reference navigation 

B.7.1  Setting the ADCP Clock 

1. Confirm that the system time zone on laptop PC is set to UTC.   

2. In the WinRiver II main screen, click on Acquire > Set ADCP Clock. 

3. Set the clock to match either PC or GPS Time (preferred if available). 

a. If GPS time is selected, ensure that time settings in Trimble are set to UTC and are both 

current and correct. 

4. Click the “Set Clock” button – note that only clicking the OK button will not set the clock.   

B.7.2 Execute an ADCP Test 

This test verifies that the ADCP is functioning properly and communicating with WinRiver II software.    

1. In the WinRiver II main screen, click on Acquire > Execute ADCP Test.   

a. Note that the ADCP must be installed in the mount and submerged in non-flowing water 

to obtain the best test results.   

2. A series of six tests will be initiated that evaluate ROM, RAM, Communications, RTC, Compass, 

and Temperature performance.  Check that all tests pass on the left pane of the dialog window.    

3. After the tests have been run, sensor data will begin to be sampled and displayed in a loop. 

4. Click the “Stop PC20” and “Stop PC40” buttons to end testing and close the dialog window.    

5. Ensure that that “ADCP test completed and passed” is checked green in the Q-View window.   

B.7.3 Calibrate the Compass 

A properly calibrated compass is essential for conducting Moving Bed Tests and for using GPS data as 

the navigation reference.   

1. Ensure that the ADCP is secured in the mount and in the exact position it will be during the 

discharge measurement.   

2. Ensure that the boat is not located near vehicles, steel bridges, or other large ferro-magnetic 

masses.  Check any materials in the boat that could disrupt the compass calibration – this 

includes tools, tool boxes, cell phones, etc.  Move these materials away from the ADCP during 

calibration and throughout the discharge measurement.   

3. In the WinRiver II main screen, click on Acquire > Execute Compass Calibration.   

4. Select Use Pitch/Roll? 

a. Click No if the ADCP will not be subject to pitch and roll (i.e. calm water).  This 

calibration test requires two rotations, one for calibration and one for verification. 

b. Click Yes if the ADCP will be subject to very high pitch and roll conditions.  This 

calibration test requires up to eight rotations, four for calibration and four for 

verification.  Typically, no pitch and roll calibration is required.   

5. Click the Start Calibration button and wait a moment until the compass is initialized by the 

software. 
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6. Begin to slowly and smoothly rotate the boat in either direction.  Do not cause sudden 

accelerations or decelerations.   If the water is shallow enough near the banks and it is safe to 

enter the water, slowly and steadily rotate the boat in a circle by hand.     

7. Rotate the boat until all of the red bars in the dialogue window have been replaced by a 

different color (dark green is best).   

a. The greener the bars, the better the data.   

b. If a bar is not dark green, rotate the boat more slowly and more smoothly.   

c. Correct any non-dark green bars when it occurs by going back 10-20° until that bar is 

once again highlighted.  Then, when it becomes dark green, proceed as before.   

8. Once both the calibration rotation is complete, click OK and continue with the verification 

rotation. 

9. Once the verification rotation is complete a calibration error will be calculated and presented.   

a. Ensure that the calibration error is less than 2°.  Aim for a total error of < 1°.   

i. If calibration error is < 2°, the compass calibration is complete and the window 

can be closed (< 1° is preferred – try to obtain this).  

ii. If calibration error is ≥ 2°, do not accept the compass calibration and repeat 

calibration procedures.  Look around for magnetic materials that may be 

affecting the compass.  Move these materials away from the ADCP or move the 

ADCP away from them, if possible.  

iii. If, after three attempts, a calibration error of < 2° cannot be achieved, reference 

the trouble shooting steps below.  If, following troubleshooting, a compass 

calibration of < 2° still cannot be achieved, accept the lowest calibration error 

possible and proceed.  Document this occurrence in the measurement field 

notes as it will be a very important footnote during data post-processing.   

 To add a note to the measurement file, right-click Site Information on 

the Measurement Control window.  Enter all notes into Remarks 

section.   

10. Once complete, check that the correct Magnetic Variation Correction value was entered by the 

software during the measurement wizard setup. 

a.  In the WinRiver II main screen, in the upper left Measurement Control window, open 

the Collect Data node and right click on Field Configuration, and select Properties.  

b. Under Properties, select Offsets. 

c. Under Offsets > Compass, verify or set the Magnetic Variation value. 

d. Note that other settings can be verified and entered in this window. 

11.  If you have a good compass calibration (have entered the Magnetic Variation correctly) and 

have good GPS data, the Ship Track lines (Ref: BT and Ref: GGA) should align (see pictures 

below).   

12. If the Ship Track display (Ref: BT) and (Ref: GGA) lines are not aligned properly (Figure 13), verify 

the compass calibration is good and that the Magnetic Variation setting is correct (east magnetic 

declination values are positive; west values are negative).   Also keep in mind that GPS latency 

will result in GPS and BT ship tracks that are not in line as will moving bed conditions. 
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Figure 13. Above: Proper compass calibration and Magnetic Variation coupled with good GPS data – lines are in agreement.  
Below: Poor compass calibration and/or Magnetic Variation is not set correctly.  Lines are not in agreement.  Check 
calibration, Magnetic Variation value, and potential Moving Bed conditions.  Check GPS coverage, latency, and satellite 
conditions.   

Troubleshooting Compass Calibration Issues 

 There may be too much magnetic interference in the area you are attempting to calibrate the 

compass.  Ensure that no magnetic materials are in the boat and near the ADCP.  Try moving the 

boat to a different area of the stream and repeating the calibration.  It may be that material on 

the streambed (rebar, trash) is affecting the calibration.   

 Computational errors may occur during calibration.  If you receive an error message indicating 

that a computational error occurred, repeat the calibration and be sure to rotate the ADCP slow 

and smooth.  Ensure that all points in the calibration display are of good quality (dark green). 

 Communication errors may occur during calibration when using a slow communication Baud 

rate.  If you receive a “Failed to get calibration data…” message verify that the ADCP 

communications are set to the 115200 Baud rate (Section 3.1.1).   

 If you receive a “360 degrees” compass error message then the compass calibration test has 

failed and needs to be performed again. 

 Disable Trimble GPS output (if enabled).   
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B.7.4 Perform a Moving Bed Test 

Moving Bed Tests (MBT) are used to determine if the bed of the section is in motion.  An un-accounted 

for moving bed can lead to 5-10% bias in discharge measurements performed with the River Pro ADCP. 

MBTs must be performed prior to each discharge measurement.  WinRiver II software analyzes the data 

collected during the MBT to assess the moving bed characteristics of the site and to detect common 

error conditions, which may invalidate the test.  The loop method is presented below as a means to test 

whether a moving bed is present.  The loop method must be applied properly, or it may produce 

incorrect results.   

Note that the accuracy of the loop method may not be adequate for mean velocities less than 0.8 

ft/second (0.24 m/s).  If mean velocity is below 0.8 ft/s (0.24 m/s), water velocity is low throughout the 

water column and the probability that the bed is in motion is decreased.   If the bed is in fact in motion 

at these velocities (or particles on the surface of the bed are in transit) it is likely that not accounting for 

it will exert only a minimum bias in the overall discharge estimation.   

1. A properly calibrated compass is critical to application of the loop method, the error caused by 

an improperly or un-calibrated compass can be in either direction, resulting in either more or 

less moving bed than actually is present.   

a. Ensure that the compass calibration error is < 2% (< 1% is preferred) before beginning 

the MBT.   

2. You must begin the MBT from an initial point where you will be able to return and stop precisely 

(see figure below).  Navigate the boat to a starting location at or near the discharge cross-

section and mark this location with an anchored float in the water for a physical reference for 

the starting point.   

3. In the WinRiver II main screen, click on Acquire > Start Pinging (F4). 

4. Open the Ship Track graph.  This allows for a better view of the boat path as it does not show 

the velocity paths. 

a. View > Graphs > Ship Tracks > Ship Track 

5. On the Acquire menu, click Select Moving Bed Test. 

6. Select “Loop Test” and click the Start button (F6). 

7. Immediately begin to slowly and steadily move the boat across the river to the opposite bank.  

Maintain a steady speed that, if possible, does not exceed the stream velocity.  Do not stop the 

boat or end the transect.   

a. Note that the green square in the Ship Track graph is your starting location.  

8. The MBT Test must last at least 180 seconds (3 minutes). 

9. At the opposite bank turn around (don’t stop) and head back to the exact starting point that was 

flagged in Step 1, as illustrated in Figure 14.  This is a critical part of the moving bed test, make 

sure this is a smooth and slow turn.       
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Figure 14. Illustration of the Loop Moving Bed Test procedure. 

 

10. Once you are back at the exact starting point where you began, (the green square in the Ship 

Track graph) immediately click F6 (Acquire > Stop Moving Bed Test).  If you don’t hit the F6 

button right at the starting point this could falsely indicate that the bed is moving.  4 

11. Review the Ship Track window (Figure 15).  Note that the red square on the Stick Track graph is 
your ending location.  If the track (red line) contains an “open loop” (i.e. the green and red 
squares do not line up and the red line is not connected) this may indicate that there is a moving 
bed. If the track does not contain an “open mouth” (i.e.t the green and red squares are on top 
of each other and the red line is connected), this indicates that a moving bed is likely not 
present. Moving bed conditions will always cause the ship track to move upstream – if the ship 
track moves downstream the loop test is not valid. 
 

      
Figure 15. Left: A moving bed is likely present (not open loop); Right: a moving bed is not likely present (note closed 
loop).    
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12. Document all relevant notes that apply to the MBT. 

i. To add a note that relates to a specific MBT, right click on the test node (i.e. 

“Loop 000”), and select “Add Note”. 

ii. To add general MBT notes to the measurement file, right-click Site Information 

on the Measurement Control window.  Enter all notes into Remarks section.   

13. Review the Moving Bed Test Result window to evaluate the results of the MBT.   

a. In the Measurement Control window, under QA/QC, click on the Moving Bed Test node 

and open the Test Result icon for the test that was just completed (Loop tests begin as 

“Loop 000”).    

b. The Test Result window provides metrics that describe the MBT.  At the bottom of the 

window reference the “NOTE” – it will indicate whether correction is recommended 

(Figure 16).   

i. If a correction is recommended, check the box to the left of the MBT (i.e. “Loop 

000”).  This will apply a correction to the measured discharge to account for the 

moving bed velocity.   

1. If a moving bed is detected and GPS data is valid, the Navigation 

Reference must be changed from Bottom Track to GPS (see Section 

B.7.5).   

a. On the main WinRiver II screen select Configure > Reference 

and change reference to either GGA or VTG. 

2. If GPS is not available due to moderate to extreme canopy cover (e.g. 

hills, mountains, forest cover, etc.) that prevents satellite acquisition 

then Bottom Track should be used as the reference navigation (See 

Section B.7.5).  Document this in the discharge measurement notes.   

3. Once the correction has been applied and the appropriate reference 

navigation has been set, proceed with the next pre-measurement QAQC 

procedure.   

ii. If a correction is not recommended and all other aspects of the MBT look OK 

then no correction is needed and Bottom Track can be used as the reference 

navigation.  Proceed with the next pre-measurement QAQC procedure.   
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Figure 16. Loop Test Result window 

 

14. If there is confusion whether or not the MBT was completed correctly or questions arise 
interpreting the results, consider the following common sources of errors associated with the 
Loop Method.   

a. Water velocity must be > 0.24 m/s in order for a moving bed to be evaluated. 

i. If velocity is below this threshold a loop test cannot be evaluated by WinRiver II.   

ii. At low velocities such as these it is likely that a moving bed is not present or is 

negligible in terms of affecting measured discharge.  Conducting an additional 

loop test is not required.  Proceed with the pre-measurement QAQC procedures 

in this instance.   

b. Systematic compass errors. 

i. Check the direction of the velocity vectors (blue lines) during the Loop Test in 

the Stick Ship Track window.  They should be pointed in the same direction 

during both loop paths.  If vectors are in opposite or in an erratic direction this is 

a symptom of poor compass calibration.   

c. Bottom-tracking bias and uncertainty. 

i. Check the Velocity Contour Profile associated with the Loop Test.  Are there 

large unmeasured areas along the streambed?  If so a MBT may be difficult to 

validate.  Conducting another MBT along a different transect may be helpful.   

d. Failure to return to the initial starting point. 

i. Make sure that you returned to the exact starting location. 

ii. Make sure that you ended the MBT at the exact time you reached the starting 

location.   
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e. Irregular or insufficient sampling of the cross section because of loss of bottom track, 

non-uniform boat speed, and loitering at the banks. 

15. If any of the above criteria are in doubt: 

a. Conduct another Loop Test and compare the results.   It may be helpful to begin the 

subsequent Loop Test from the opposite bank or from a different transect location.  Be 

sure not to get too far away from where you will be collecting the discharge 

measurement however.   

B.7.5 Configure the Reference Navigation  

1. In the WinRiver II main screen, click on Configure > Reference. 

2. If a moving bed is not present, ensure that “Bottom Track” is selected from the list. 

a. When bottom track is used as the velocity reference, the speed of the ADCP over 

ground is subtracted from the measured relative velocity to give true Earth referenced 

water velocity. 

3. If, following a moving bed test, a moving bed is present and GPS can be utilized, choose GGA or 

VTG as the reference navigation.    

a. If GPS does not have enough satellites to acquire a strong signal, Bottom Track should 

be used as the reference navigation.     

b. GPS latency can be detected using the Ship Track window.   Compare the red lines 

(Bottom Track) vs the blue and green lines (GPS).  If there is some separation between 

GPS and BT that usually denotes latency.   

4. Determine which velocity reference method is in use at any time during the measurement by 

referencing the text lines just above and below the scales at the top and bottom of the Ship 

Stick Track graph display.  At the end of each line is an indication of what reference is being 

utilized.   

 

B.8 Methods: Collecting Stream Discharge Data  

The WinRiver II software calculates discharge as velocity is measured in real-time during measurement 

transects across the river.  Perform the following steps in order to successfully collect a high-quality 

stream discharge measurement. 

B.8.1 Begin Acquiring Data  

1. Ensure that all steps listed in Section 3 were performed (check Q-View window for green check 

marks next to all applicable procedures).  

2. Re-check the staff gauge to ensure that the stage has not changed.  If a change in stage has 

occurred, record this change in the general field notes.    

3. Record all notes that are relevant to the instrumentation setup, environmental factors (high/low 

flows, wind conditions, the passage of other vessels during measurement), and any other 

noteworthy events that occur before, after, or during the discharge measurement.   
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a. To add a note to the measurement file, right-click Site Information on the Measurement 

Control window.  Enter all notes into Remarks section.   

4. Press F4 to start the ADCP pinging (or on the main WinRiver II screen select Acquire > Start 

Pinging). 

a. In a few seconds, you will see changing values in several of the data windows. The 
ensemble number will update, the time displayed just below the ensemble number will 
change to show the ADCP time of each ensemble, the position sensors will update, and 
so on. And, if you have the ADCP in sufficiently deep water, you will see velocity profiles 
on the graph. Note: WinRiver II will not display meaningful data if your system is not in 
water. 

b. GPS positions will be displayed at the bottom of the Composite Tabular display window 
if enabled and valid GGA positions are being received from the GPS system.  External 
Heading and Depth Sounder data will also be displayed in that window if enabled. 

c. In general, after you have started the ADCP pinging, there is no reason to stop pinging 
until you are finished and ready to remove the ADCP from the water. An exception 
would be if you were operating off of batteries with limited capacity. Then stopping 
pinging will conserve power. 

d. It is OK to let the ADCP ping when it is not in the water. 
 

B.8.2 Establish Transect Start and End Points 

Because river depths eventually become too shallow for valid data collection as the ADCP approaches a 

bank, it is necessary to estimate discharge in the near-shore unmeasured zones using the WinRiver II 

software. To ensure the accuracy of near-shore discharge estimates, the distances from the edge of 

water to the starting and stopping points of each transect must be measured using a distance-

measurement device (such as a laser or optical rangefinder), tagline, or some other accurate 

measurement device. 

The starting/stopping locations at each side of the channel must be established.  Placing anchored 

marker buoys at the start and end points of transects is advantageous for keeping consistent edges and 

ensuring that the same cross-section profile is measured during each transect.  

When measuring in channels with vertical walls at the edges, start and stop points for transects should 

be no closer to the wall than the depth of water at the wall to prevent acoustic interference from the 

main beam or side lobes impinging on the wall. For example, if the depth at a vertical wall is 10 feet, 

transects should start or stop at least 10 feet away from the wall. 

If the cross-section has been measured previously at the same location, WinRiver II “Locations” can be 

utilized to help determine the start and end points that were previously used and to help navigate 

across the channel.  See Section 4.8 for instructions on loading available locations and how to save new 

ones.       
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To establish transect start and end points: 

1. Push the boat just off the shore and into open water until the ADCP transducers are submerged. 

2. In the WinRiver II main screen, click on View > Tabular > Velocity.  

3. The tabular display will determine when the water is deep enough to provide a discharge value 

in the top two depth cells or “bins”.  Two “good bins” are required in order to start and stop the 

transect measurement.   

a. When the top two rows (or bins) of the display are black, you are at a sufficient depth to 

begin velocity measurements (see below figure) and establish a transect start/end point.   

b. Set the start and end points as close to the shore as possible with two good bins.  Keep 

in mind that the further you get away from the bank the farther the software will have 

to interpolate discharge. 

c. Try to ensure that the velocity at the start/end marker location is representative of the 

velocity leading up to the bank.  Again, the software interpolates the near-shore velocity 

using the velocity measured at the start/end points.  If the velocity profile near the 

banks are significantly different than conditions at the markers the edge data will be 

biased.   

d. You can also track the number of “good” bins in the Composite Tabular window.  Select 

View > Tabular > Composite.  In the “Discharge” table, ensure that the number of Good 

Bins is equal to 2 (or greater, but not much more).   

4. Move the boat slowly away from the bank until the tabular display indicates you are at a 

sufficient depth to begin the discharge measurement. 

a. Remember that if a vertical wall is present on the side of the channel, the start and end 

points for the transect should be no closer to the wall than the depth of water. 

5. Mark this location with a marker buoy or weighted float.   

6. Slowly and steadily move the boat from this location towards the opposite shore.  Travel 

smoothly and slowly with the bow of the boat pointed upstream.   

a. While moving across the channel to mark the opposite start/end point ensure that the 

ADCP is working as expected with the loaded configuration.   

b. Note the Velocity Contour Graph (if not already displayed select Graphs > Contour > 

Velocity) while you move across the stream (Figure 17).  Use this display to see how the 

water depth changes as you make your transect.   

c. Note regions where the bottom depth changes abruptly.  Make a mental note to move 

more slowly across these regions during data acquisition to help bottom tracking 

maintain a valid lock on the bottom. 

d. Note regions in the Velocity Contour profile that contain large white bands.  These are 

unmeasured areas in the cross-section.  They can occur for a number of reasons – large 

debris in the channel, upstream structures such as bridge pilings, etc.  If the unmeasured 

area within the cross-section is significant a different discharge transect upstream or 

downstream is necessary.    
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Figure 17. Velocity Contour Graph 

 

7. As you approach the opposite shore pay attention to the tabular display (Figure 18) and mark 

the closest distance to the shore where the top two depth cells are black and display discharge 

values (two good bins).   

8. This location will be the transect start and end point for this side of the shore.   Again ensure 

that the flow conditions at this location are representative of conditions leading up to the bank.   

9. Mark this location with a marker buoy or weighted float.   

 

 

Figure 18. Velocity Tabular Display showing two good bins in red indicating that the location is valid transect start 
and end point.  Note the discharge values in the far right columns. 
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B.8.3 Hold Position at the Starting Channel Edge 

1. Hold the position of the boat steady at one of the marked transect start and end points.   

2. Using a stadia rod, meter tape, or laser range finder, determine the edge distance to the shore. 

a. Measure the area from the top of the ADCP to the edge of the water on the bank.  If the 

ADCP is on the opposite side of the boat, be sure to measure from this area to the edge 

of water. 

b. If using a rangefinder make sure that the laser is not hitting leaves or branches hanging 

over the channel.  Take a few shots and make sure they are all the same.   

3. Press F5 to begin data recording.   

4. When prompted, enter the beginning edge distance to the edge of water.   

5. Define whether you are nearest to the left or right bank (when facing downstream, the left bank 

is on your left side).   

6. Hold the position of the boat at the marked start and end point for at least 10 shore ensembles 

(this should take about 10 seconds or so).  The number of ensembles can be tracked at in the 

Composite Tabular window. 

B.8.4 Cross the Channel  

1. Once the shore ensembles are recorded at the edge of the transect (~10 seconds = 10 

ensembles), slowly and steadily move the boat away from the shore.  Make a steady heading 

for the start/end point marked on the opposite end of the shore.   

2. Move the boat slowly and steadily across the channel.   

a. Move slowly.  Each transect must take at least 3 minutes (180 seconds).  The 

cumulative time spent measuring each transect is a critical component of collecting a 

high-quality discharge measurement. The slower and steadier you cross the channel the 

better the results. 

b. Maintain an average boat speed that is less than or equal to the water velocity.  Monitor 

this using Water Speed vs Boat Speed graph (View > Graphs > Time Series > Water/Boat 

Speed (Figure 19). 

i. When water velocity is very slow, keeping the boat speed below the water 

velocity may not be a possible (or practical) approach.  Under these conditions 

the smoothness of boat operation becomes critical.   

c. Avoid fast and sudden accelerations.  Smooth boat operation is more important than a 

straight-line course though it is important to end up at the same start/end location. 

d. Since you will be crossing very slowly you will be forced to point the bow of the boat 

upriver and crab across. 
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Figure 19. Water Speed vs. Boat Speed graph.   Above: Improper technique.  The boat speed (purple line) is erratic and higher 
than the water velocity (red line).  Below: Proper technique.  Maintain an even boat speed so that the purple and red lines 
are more in line and boat speed remains generally lower than water speed.   

 

3. As you move across the channel take some time to experiment with different display options. 

The display scales can be changed by right clicking on a graph and selecting Properties.   

a. View the discharge for the top, middle, and bottom layers on the Composite Tabular 

screen.  

4. Using the various displays, continuously monitor the data being collected. If a critical data-

quality problem is observed during a measurement transect it may not be used for the total 

discharge measurement.   

e. Make note of any problem related to undesirable measurement-section characteristics, 

a new measurement section should be located and noted on the measurement field 

note form.  To add a note to the measurement file, right-click Site Information on the 

Measurement Control window.  Enter all notes into Remarks section.   

B.8.5 Holding Position at the Ending Channel Edge 

1. Continue across the channel until you reach the start and end transect point on the opposite 

shore.   
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2. At this location ensure that discharge values are present in at least two depth cells of the 

Composite Tabular graph. 

3. Hold the boat steady at this location and wait until at least 10 shore ensembles have been 

collected (~10 seconds = 10 ensembles). 

4. Using a stadia rod, meter tape, or laser range finder, determine the edge distance from the top 

of the ADCP to edge of water on the shore.   

5. Press F5 to stop recording data.   

6. You will be prompted to enter the edge distance.  Enter the value of the distance from the top 

of the ADCP to edge of water on the shore.   

7. If possible check the staff gauge to ensure that the stage did not change during the course of the 

measurement.  If a change in stage occurred, record the observed gauge height for each 

transect in the transect notes (see below).   

8. To add any notes that relate specifically to the transect discharge measurement, right click on 

the Transect number and select “Add Note”.   

a. Examples include: 

i. “A barge went through the transect during the discharge measurement” 

ii. “The wind picked up considerably during the transect measurement” 

iii. “It was difficult to maintain a boat velocity less than the mean velocity of the 

river during this transect due to…” 

iv. “Poor bottom tracking during this measurement due to…”  

v. “River stage appeared to rise/fall while measuring this transect” 

vi. “High sediment concentration was present during this measurement” 

9. The first transect measurement is now complete. 

10. To view the data you collected during the transect open the node (+) under the Transect name 

and double-click the disc button.   

B.8.6 Collect At Least Three Additional Transects (Minimum of Four Total Required) 

Repeat the steps presented in the previous section, navigating across the channel from each start and 

end point until a total of four transects have been measured (two in each direction).  A minimum of four 

transects must be collected during each discharge measurement, two in each direction.  The measured 

discharge is the average of the discharge collected during each transect.   

Re-check the staff gauge prior to each transect measurement.  Record any gauge height changes in the 

individual transect notes. 

Hit the F5 key to start and stop recording data for each passage across the channel while letting the 

ADCP ping continuously.  A new data file and configuration node will be created in the Measurement 

Control window each time you start and stop recording (ex: Transect 0000, 001, 002, 003), and the 

starting and ending edge distances along with any entered notes will be saved in the measurement file.     

Once the fourth transect is complete and you are ready to stop data collection and evaluate whether 

more transects are needed, press F5 to stop data collection and F4 to stop pinging.   



 Title: AOS Protocol and Procedure: Stream Discharge Date:  10/11/2018 

NEON Doc. #:  NEON.DOC.001085 Author: N.Harrison Revision:  F 

 
 

Page 64 of 73 
 

B.8.7 Evaluate Whether More Than Four Transects Are Required 

More than four transects must be measured if: 

1. The relative residual (RR) for at least one measured transect is greater than the maximum 

permissible relative residual (MPRR) calculated based on all transects. 

2. The discharge measured during at least one transect is greater than 5% of the average discharge 

of all transect measured.   

3. An observed gauge height change is associated with a notable change in discharge for a given 

transect.   

4. Total transect duration does not exceed 720 seconds. 

Evaluate the Relative Residual (RR) of each transect: 

1. In the WinRiver II main screen, hit the F12 button to bring up a summary table of each transect 

measured. 

2. Ensure that all rows in the summary table are black.  This indicates that the relative residual (RR) 

is less than the maximum permissible relative residual (MPRR) for each transect.  The software 

will assign a higher MPRR with increased number of transects.    

3. If all rows of the summary table are black, all RR requirements are met.  Proceed to the next 

evaluation step where you will evaluate the discharge of each transect relative to average 

discharge of all transects. 

4. If any rows of the summary table are red: 

a. Collect two additional transects, one that begins on the left bank and another that 

begins on the right bank.   

b. Once two additional transects have been measured, evaluate the summary table again 

(F12) and ensure that all rows are black. 

c. Continue to collect transect pairs until all rows of the summary table are black. 

d. If, after collecting a total of 10 transects, a least one row of the summary table remains 

red, proceed to the next evaluation step and submit a trouble ticket to Science when 

you return to the office. 

e. Remember the RR assumes an unchanging hydrograph – if the stage was fluctuating 

throughout the discharge measurement, more transects may not be needed.   

Evaluate the discharge of each transect relative to average discharge of all transects: 

1. In the WinRiver II main screen, hit the F12 button to bring up a summary table of each transect 

measured. 

2. Note the value listed in the “Total Q” column for each transect row.  This is the total discharge 

measured during each transect. 

3. Note the value listed in the “Average” row of the “Total Q” column – this is the average 

discharge of all transects measured. 

4. If the discharge measured during each transect is 5% or less than the average discharge of all 

transect measured, all average discharge requirements are met.  Proceed to the next step.   
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5. If the discharge of any of the four transects measured differs by more than 5 percent from the 

mean measured discharge: 

a. In changing stage conditions discharge measured within individual transects may exceed 

5% of the mean.  If the hydrograph is fluctuating, additional transects may not be 

needed (see below).   

b. Collect two additional transects, one that begins on the left bank and another that 

begins on the right bank.   

c.  Once two additional transects have been measured, evaluate the summary table again 

(F12) and check if discharge measured during each transect is less than or equal to 5% of 

the average discharge calculated from the total number of transects. 

d. If transect discharge still exceed 5% of the average, collect two more transects, one that 

begins on the left bank and another that begins on the right bank.   

e. If, after collecting a total of 10 transects, discharge from at least one transect exceeds 

5% of the total average, proceed to the next evaluation step and submit a trouble ticket 

to Science when you return to the office. 

f. Keep in mind that the more transects that are measured increases your confidence that 

you will obtain a true average of the discharge but it also increases the probability of an 

outlier.   

Evaluate changes in transect discharge relative to changes in gauge height  

The staff gauge must be checked prior to each transect measurement in order to assess unsteady flow 

conditions.  Unsteady flow conditions occur during periods of rising or falling stages which may occur 

during or immediately following heavy rain events, upstream dam or lock flow regulation, tidal effects, 

downstream backwater effects, or flood waves.   

Always document unsteady flow conditions in both the general and transect-specific measurement 

notes.  To add any notes that relate specifically to the transect discharge measurement, right click on 

the Transect number and select “Add Note”.  To add a more general note to the measurement file, right-

click “Site Information” on the Measurement Control window.  Enter all general notes into Remarks 

section.   

If a gauge height change is associated with a notable change in discharge for a given transect (i.e. > ~3% 

of the mean), collect an additional transect measurement that corresponds with the same gauge height 

from the opposite bank.  Be sure to note which transects are associated with which gauge heights in the 

transect measurement notes.   

Additional points regarding discharge transects: 

1. Always measure reciprocal transects.   

a. Reciprocal transects are a pair, or set of two transects, where one transect begins from 

the left bank and one transect begins from the right bank.   

b. Reciprocal transects reduce the potential for directional biases which may occur when 

the discharges measured for transects from the left bank to the right bank are 
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consistently either greater than or less than discharges measured for transects made 

from the right bank to the left bank.    

c. Never finish the discharge measurement with an odd number of transects.   

 

B.8.7 Transect Locations 

Location files contain the preferred starting and stopping points for transects.  Using GPS data, WinRiver 

II can save transect locations for a given measurement cross-section to help navigate from the starting 

and stopping points for the transects.  This feature cannot be utilized with integrated GPS data.   

Following the first discharge measurement at a suitable cross-section the transect locations should be 

saved so that they can be used during subsequent discharge measurements.  Note that you only need to 

save the transect location following the first discharge measurement at a suitable cross-section.  

However, if a different cross-section is measured on the same river (i.e. 50 meters upstream or 

downstream of the normal cross-section), a new location will need to be saved in order to be used 

again.  Make note of this occurrence in the general measurement field notes window.   

To create a location file: 

1. Use the Measurement Control window to identify the transect with preferred starting and 

stopping points for the cross-section. 

a. Note that the data file must have contained GPS data in order to create the location file.   

2. Rick-click on the preferred transect and select “Define Transect Location” (Figure 20). 

 

 

Figure 20. Defining transect locations. 

3. The transect will process and then display the Edit Locations screen.  Click on the map to zoom. 
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4. Enter a Location Name, any relevant notes about the location as needed, and then click the Save 

& Close button.  

a. Note that you must click the Save & Close button to create the location file.  Clicking the 

Cancel or using the X to exit the Edit Locations screen will nor create the location file. 

5. Click Save on the Save Location scree.  The *.dat location file will be saved to the 

C:\Measurements\Locations folder.   

To edit a location file: 

1. Use the Measurement Control window and right-click on the measurement file and select “Edit 

Locations” (Figure 21). 

2. Click on one of the files from the “Saved Locations” box to select the file to edit.  Enter any 

changes to the file as needed. 

3. Click the Save & Close button to save the changes.  If the file already exists, you will be 

prompted if you want to replace the file.   

 

 

Figure 21. Editing transect locations.  

 

To load a location file: 

The location file (*.dat) must be saved in the C:\Measurements\Locations folder (Figure 22) and 

WinRiver II will automatically use the location file if the transect is within approximately 100 meters of 

the locations specified in the file.  The ADCP must be using GPS in order to use locations.   
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Figure 22. Loading location files 

 

You may need to manually scale the ship track display in order to see the location line in the display 

(Figure 23), if the location line is sufficiently far from the transect position.  Right click on the Ship Track 

graph window to scale the display up or down.  A black line will display across the Stick Ship Track 

display to help navigate from the starting and stopping points for the transects (see figure below).  This 

line can be followed while moving the boat across the channel.   

 

Figure 23. A black line is displayed between saved transect locations in the Ship Track display window. 

 

B.9 Methods: Field Data Review 

Following the completion of the discharge measurement, WinRiver II and Q-View can be used to review 

the data that has just been collected.  Each of the transects measured should be played back and 

checked prior to leaving the site.   
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1. Check Q-View 

a. All Procedure and Measurement rows should contain a green check.   

b. If the MBT was completed but not valid (i.e. due to low velocity) than the red X will 

remain next to this row. 

c. If Rated Discharge is not available, the red X will remain next to this row.   

d. All other rows must have a green check mark.  If a red X is present next to a given field 

investigate the source of the issue before leaving the site.   

 

2. Playback each measured transect and check parameters. 

a. Open the node (+) under each transect. 

b. Right click on the Transect number and select “Re-process Transect”.  The transect data 

will appear in all graphs that are currently on display. 

c. Right click on Playback Configuration and select “Properties”. 

i. In the Edge Estimates page on the right, verify that the Begin Transect and End 

Transect information was entered correctly. 

ii. In the Offsets page check that the ADCP transducer depth was entered correctly 

(generally, this depth does not change across all transects). 

iii. In the Discharge page choose the correct Left Bank and Right Bank Edge Type.   

1. Once entered, right click each area and select “Apply to All Active 

Checked Transects”.  This will apply the setting to all transects in the 

measurement.  Each transect will need to be re-processed for this 

change to be applied to the discharge measurement.   

a. If either edge does not conform to a “Triangle” or “Square” 

shape, document this in the measurement note window and 

contact Science to discuss the correct edge coefficient that 

should be entered.  These values are very important in 

estimating edge discharge.   

 

3. Enter all applicable notes in the general measurement field notes window and in individual 

transect windows, as necessary. 

 

4. Save the .MMT file and all .PDO files on a USB drive as well as on the laptop for backup 

purposes. 

 

B.10 Methods: Uploading the Measurement File 

Unlike discharge measurement files collected at wadeable stream sites, raw (files that have not been 

post-processed) ADCP discharge measurement files are stored on an online file storage page and post-

processed by Science.  Complete the following steps to upload discharge measurement files.  

1. Once you are back in the office, store the measurement file on the cloud-based Box.com folder. 



 Title: AOS Protocol and Procedure: Stream Discharge Date:  10/11/2018 

NEON Doc. #:  NEON.DOC.001085 Author: N.Harrison Revision:  F 
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a. Navigate to the main Box.com folder where raw ADCP files are stored.    
i. “NEON River Discharge ADCP Measurement Files” 

https://app.box.com/folder/48084982589) 
b. Navigate to the applicable Domain folder for raw files. 

i. Ex: “Domain_03_Raw_Files” 
c. Navigate to the appropriate site folder. 

i. Ex: “D03_FLNT_Raw_Files” 
d.  Navigate to the appropriate calendar year.   
e. Create a new folder that is unique to your discharge measurement. 

i. Click the “New” dropdown and select “Folder”. 
ii. Ensure that the folder name is in a standardized format. 

i. Ex: “SITE_YYYY-MM-DD” (FLNT_2018-03-17) 
f. Move all of the measurement files into this folder.  

i. This includes .MMT, and .PDO files - everything that was saved on the laptop/USB. 
ii. If anything else that corresponds to the discharge measurement is notable (i.e. 

pictures, screen shots, etc.) create a sub-folder here where they can be stored. 
g. Notify Science that the discharge measurement is complete and the files have been 

uploaded.   
 

https://app.box.com/folder/48084982589

